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EA SY' RO B ™ Bedienungshinweise
Einleitung

Ubersicht der Dokumentation und die Installation

Die Bedienungshinweise werden Sie bei der Arbeit mit EASY-ROB™ unterstitzen. Die Bedienungshinweise
enthalten detaillierte Information die erforderlich sind, um die Software mit allen Funktionalititen von Anfang
an richtig zu nutzen.

Neben Informationen Uber die System-Dateien flr die grundséatzliche Konfiguration bzw. das
Erscheinungsbild, gibt es Beschreibungen tber die Short Keys oder die Hauptdialoge und ein paar kurze
Tutorials.

Fur die optimale Unterstiitzung nutzen Sie bitte die gesamte verfligbare Dokumentation zu EASY-ROB™.,

Liste der existierenden Dokumentation :
- Produktbeschreibung
(Allgemeine Beschreibung aller EASY-ROB™- Produkte, Optionen und API’s)
- Bedienungshinweise
(Wie nutzt man EASY-ROB™. Detaillierte Beschreibung zu System-Dateien, Funktionen und
Dialogen)
- EASY-ROB-ERPL
(Referenz zu ERPL- und ERCL-Sprache)
- TrainLib-Tutorial
(Schulungsunterlagen)
- Installationsanleitung
(Detaillierte Beschreibung fiir die gesamte Installationsprozedur)

Bitte installieren Sie auch die folgenden Bibliotheken:
- TRAINLib (Schulungsbibliothek)
(Die Schulungsbibliothek unterstiitzen den Bediener bei den ersten Schritten in EASY-ROB™ von
der leeren Arbeitszelle bis zur Simulation)
- Beispielordner “Proj_example_erpl’
(Die Beispiele zeigen die Anwendung der ERPL- und ERCL-Sprache)

Installation:
Fir die Installation von EASY-ROB™ folgen Sie den Anweisungen des Dokuments “Installationsanleitung”.
Darin ist die gesamte Installationsprozedur detailliert beschrieben.
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EA SY' RO B ™ Bedienungshinweise
Einleitung

Inhalt der Installations-CD

Im Hauptverzeichnis befinden sich die Installationsprogramme fiir die folgenden
EASY-ROB™-Produkte

¢ Installationsanleitung.pdf Anleitung zur Installation von EASY-ROB™
e EASY-ROB App Setup x64.exe EASY-ROB™ App Professional, Education Version
¢ EASY-ROB LicenseManager Setup.exe EASY-ROB™ Lizenz Manager
e EASY-ROB Viewer Setup x64.exe kostenfreie EASY-ROB™ Viewer Version
e EASY-ROB Demo Setup x64.exe kostenfreie EASY-ROB™ DEMO Version
Installationsanleitung-DEMO.pdf mit Anleitung zur Installation
Technische Anderungen und Verbesserungen sind vorbehalten 5/109
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Inhalt der Installations-CD

Unterverzeichnisse:

/Easy_Rob_EROSA

Project
/Easy_Rob _Kernel

/Easy_Rob_Updates
/Easy_Rob_Framework_Update

/Easy_Rob_App_Update
/Easy_Rob_Kernel
/Easy_Rob_Viewer_Update
/SystemFilesTemplate

)
/Easy_Rob_Viewerx64

/EasyEdit-Offline-Programm-Editor

O 0O O O O O

Lackierprogramme)
/[Famos-Demoversion V9

/Foxit-PDF-Reader

/Manual
wie

/Options

Beispiele
/Product-Info
/RobotLib

/SystemDlls
/TeamViewer

o TeamViewerQJ*.exe
o TeamViewerQS*.exe
/WibuKey

/Easy_Rob_LicenseManager_Update

EASY-ROB™ Offene Softwarearchitektur mit
API Beispielen als Microsoft® Visual Studio 2017

Beispiele und Dokumentationen zum
EASY-ROB™ Kernel

Update Archive fir die folgenden Produkte
EASY-ROB™ Framework

EASY-ROB™ Lizenz Manager

EASY-ROB™ App Professional, Education Version
EASY-ROB™ Kernel

EASY-ROB™ Viewer Version

Vorlagen fir Systemdateien (config.dat, easy-rob.pth,

kostenfreie EASY-ROB™ Viewer Version

EasyEdit™, eine kundenspezifische Lésung von
b+m surface systems GmbH (OLP fur

Famos robotic® Demoversion von carat robotic GmbH,
verwendet den EASY-ROB™ Kernel

Foxit-PDF-Reader® zum Lesen von PDF-Dateien
Beispiele und Beschreibungen als PDF-Dokumente

Bedienungs-Hinweise.pdf, EASY-ROB-ERPL_DE.pdf

VRML-Examples.zip mit Beispielen zur Konvertierung
von VRML 11,97 -Dateien in das IGP-Format und
anschliefiender Optimierung ,merge”.
CAD-Import.zip: IGES-, STEP-, VRML-Import-

PDF-Dokumente zur EASY-ROB™ Product Suite

Vollstandige Roboterbibliothek
ABB, KUKA, Staubli, Fanuc, Yaskawa
b+m, Comau, Mitsubishi, Universal Robots...

Microsoft® Visual C++ Redistributable 2017
TeamViewer fiir Prasentation und Remote-Support
Startet EASY-ROB™ TeamViewer QuickJoin
Startet EASY-ROB™ TeamViewer QuickSupport
Setup fir WibuKey & CodeMeter Dongle Treiber

Technische Anderungen und Verbesserungen sind vorbehalten
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EA SY'ROB ™ Bedienungshinweise
System Dateien

Environment Datei: easy-rob.env

Die Environment Datei “easy-rob.env” enthalt alle Initialeinstellungen firr die Erscheinung / das Aussehen
von EASY-ROB™ und wird automatisch bei jedem Start von EASY-ROB™ geladen.

AuRerdem kann der Bediener die Environment Datei mittels eines ERC-Kommandos wahrend einer
Simulation laden und somit die Einstellungen andern.

Die Datei enthalt z.B. Variablen um
- den FuBboden ein- oder auszuschalten
- die Hintergrundfarbe zu veréndern
- den Style der Toolbars zu &ndern
- Clipping Planes zu setzen
- etc.

Mit einer “eigenen” Environment Datei kann jeder Bediener das EASY-ROB™ mit den ,eigenen®
bevorzugten Einstellungen starten und nutzen.

Die Variablen verandern kann der Bediener auf zwei verschiedenen Wegen:
a) Editieren der Datei ,von Hand"
b) Andern der Einstellungen in der Anwendung und abspeichern der Datei

Um die Datei zu editieren kann der Bediener
den Tastenkombination verwenden : “Alt+Shift+E”

oder das Meni nutzen: File Menu ->Edit-> EASY-ROB System files-> ,Environment file*

Um die Umgebung nach Anderungen in EASY-ROB im Environment File zu speichern:

File Menu ->Save-> ,Environment file*

Anmerkung:
Ein Ausrufezeichen (!) am Anfang einer Zeile in der Systemdatei steht fiir eine Kommentarzeile. Sie
kénnen jeglichen Kommentar in diese Zeile schreiben — sie wird bei der Ausfiihrung ignoriert.
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Environment Variablen

Kommando und Syntax

Gultige Werte

Beschreibung

FLOOR_ON

0;1

Aus-/ Einschalten des Bodens

FLOOR_WIRE_ON

0;1

Aus-/ Einschalten des Bodens als Drahtmodell

FLOOR_LENGTH

0.100000 ..... 25.000000

Lange des Bodens [m]

FLOOR_DLENGTH

0.100000 ..... 25.000000

Lange eines Quadrats des Bodens [m]

FLOOR_POSITION

XY ZRXRYRZ
X,Y,Z:+/-0.000.....~
RX, RY, RZ: +/- 0.00 .... +/-180.00

Position des Bodens bezogen auf Welt Null
X,Y,Z [mm]; RX,RY,RZ [deq]

Tipp:

Nutzen Sie die Funktion um den Boden zu
verschieben, wenn der Nullpunkt der
Arbeitszelle nicht auf dem Boden liegt.

FLOOR_COLOR

0.0..1.0 0.0..1.0 0.0..1.0
0.0..1.0

Farbe des Bodens [R G B]

Beispiel:
FLOOR_COLOR 0.6800 0.6850 0.6850

BACKGROUND_COLOR

0.0..1.0 0.0..1.0 0.0..1.0

Farbe des Hintergrunds [R G B]

Beispiel:
BACKGROUND_COLOR 0.0050 0.0000
0.3200

HITHER 0.020000

0.000500 ..... 4.000000

Setzen der ,vorderen® Clipping Plane [m]

YONDER 20.000000

1.000000 ..... 200.000000

Setzen der ,hinteren® Clipping Plane [m]

VIEW_STEPS

Setzen View Schrittweite

TOOLTIPS

Ein-/ Ausschalten der Tips, die beim
Uberfahren mit dem Mauszeiger angezeigt
werden.

COI_ON

0;1

Ein-/ Ausschalten des Center Of Interest.

2_MOUSE_BUTTONS

0;1

Aus-/ Einschalten der 2-Knopf-Maus

Tipp:

Setzten Sie die Variable auf ,1“ (Einschalten),
wenn Sie eine 2-Knopf-Maus verwenden. Die
mittlere Maustaste wird dann tber das
gleichzeitige driicken der linken und rechten
Maustaste realisiert.

MONI_MSG_OUTPUT

0;1

Aus-/ Einschalten Monitoring MSG

Technische Anderungen und Verbesserungen sind vorbehalten
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Environment Variablen

Kommando und Syntax

Gultige Werte

Beschreibung

39.370079 inch

S3DM_MENU 0;1 Aktiviert/deaktiviert Space Mouse Menu
S3DM_SPEED 1.0 Space Mouse Empfindlichkeit
S3DM_THRESHOLD 1.0 Space Mouse Schwellwert
M_TO_UNIT 1000.000 mm Bedienerdefinierte Einheiten

1.000000 m

Die interne EASY-ROB™--Einheit ist “Meter”.
Die Variable “M_TO_UNIT” definiert in
welcher Einheit alle Werte im EASY-ROB™
dargestellt werden.

(Im = 1000mm = 39.37inch)

Beispiel:

M_TO_UNIT 1000.000000 mm -> alle
Werte werden in “mm” dargestellt
M_TO_UNIT 39.370079 inch -> alle Werte
werden in “inch” dargestellt

(siehe auch Menu -> View: ->Graphic View
Data)

REMOTE_MSG_OUTPUT

0;1

Aus-/ Einschalten von ,Remote messages*
im Message Window

REMOTE_TRACE_FILE

REMOTE_TRACE_PRG.PRG

Wenn eine ,Remote-Verbindung“ besteht,
werden die Remote-Kommandos in der Datei
gespeichert

EXPORT_FILE

0;1

Aus-/ Einschalten der Exportfunktion fur
Arbeitszellen

(Die Funktion exportiert alle beteiligten Parts
einer Arbeitszelle beim Speichern. So kann
sichergestellt werden, dass alle notwendigen
Teile fur z.B. einen Datenaustausch
zusammen sind.

(siehe auch Bedienungshinweise)

ENABLE_RUNTIME

0;1

Aus-/ Einschalten der RunTime-Funktion fir
Arbeitszellen

TOOLBAR_MODE

2:0;1

Andern des Toolbar Styles
0-Standard Icons

1-Neue Icons Normal

2-Neue Icons Hot (dies ist Default)

SHOW_TAG_CONNECT

0;1

Aus-/ Einschalten ,Verbinde alle Tags im
aktuellen Pfad*
(siehe Bedienungshinweise -Tag Window)

Technische Anderungen und Verbesserungen sind vorbehalten
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Environment Variablen

Kommando und Syntax | Gultige Werte

Beschreibung

SHOW_TAG_TEXT 0;1

Aus-/ Einschalten der Darstellung des
Namens aller Tags im aktuellen Pfad
(siehe Bedienungshinweise -Tag Window)

TAG_APPROACH_DIREC |1;-1;2;-2;3;-3
TION

1 use x direction for picked normal
-1 use -x direction for picked normal
2 use y direction for picked normal
-2 use -y direction for picked normal
3 use z direction for picked normal
-3 use -z direction for picked normal

GRAD_BCKGND 0;1

Aus-/ Einschalten des graduierten
Hintergrund

Empfehlung: Setzen Sie “GRAD_BCKGND
0” (OFF), wenn die Grafikkarte
wunterdurchschnittlich® ist.

STOP_UNREACH 0;1

Aus-/ Einschalten ,Stoppe bei unerreichbarer
Position®
(siehe Meni-> Simulation -> Run Settings)

STOP_SWE 0;1

Aus-/ Einschalten ,Stoppe bei Erreichen der
Verfahrlimits*

KEEP_IN_TRAVEL_RAN |0;1
GE

Aus-/ Einschalten ,halte Robot Joints in
Verfahrbereichen®

Annahme:

1. Achse 6 (rotZ) hat Limits swe=[-180,+180];
2. KEEP_IN_TRAVEL_RANGE auf ON (1)

Wenn die Achse auf z.B. “+181°” dreht, wird
der Achswert automatisch auf “-179°”
gesetzt, damit die Mathematik im
Hintergrund die Winkel in den Limits
berechnet.

Um die Mathematik im Hintergrund den
kirzesten Winkel zum vorherigen
Achswinkel berechnen zu lassen, muss die
Variable auf OFF (0) gesetzt werden.

Der Zustand (OFF) ist Default, weil in der
Praxis haufiger angewendet.

STOP_SPEED 0;1

Aus-/ Einschalten ,Stoppe bei
Uberschreitung der Geschwindigkeit®

STOP_ACCEL 0;1

Aus-/ Einschalten ,Stoppe bei
Uberschreitung der Beschleunigung®

STOP_COLLISION 0;1

Aus-/ Einschalten ,Stoppe bei Kollision*

Technische Anderungen und Verbesserungen sind vorbehalten
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Environment Variablen

Kommando und Syntax

Gultige Werte

Beschreibung

USE_VBO

0;1

Aus-/ Einschalten Vertex Buffer Objects
(falls von Grafikkarte unterstiitzt)

Anmerkung:

Bei Nutzung von VBO wird die Geometrie in
die Grafikkarte geladen. Um die Rendering-
Performance zu steigern, sollte die
Geometrie gemerged sein.

VBO erfordert mindestens die OpenGL
Version 1.5

(Prifen der vorliegenden Version:

Meni -> Aux -> Show current Settings)

Bei unerwinschten Effekten (auch mit
OpenGL Version 1.5) setzen Sie USE_VBO
auf OFF.

DISABLE_CROBOT_BBO
X

0;1

Aus-/ Einschalten ,Visualisierung der bBox
fur den aktuellen Roboter*

DISABLE_3D_CAD_BBO
X

0;1

Aus-/ Einschalten ,Visualisierung der bBox
fur das aktuelle 3D CAD -Objekt

DISABLE_TOOLBAR

00000000 .... 11111111

Ein-/ Ausschalten ,Toolbar*

Bit O: alle Toolbars ein

Bit 1: Load,Save Toolbar
Bit 2: Render Toolbar

Bit 3: Run Toolbar

Bit 4: OnOff Toolbar

Bit 5: 3DCad Toolbar

Bit 6: Move Toolbar

Bit 7: MouseMove Toolbar

Beispiel 00010000 --> Bit 3 schaltet Run
Toolbar aus

Beispiel 01111110 --> schaltet nur
MouseMove Toolbar ein

Technische Anderungen und Verbesserungen sind vorbehalten
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Environment Variablen

Kommando und Syntax

Gultige Werte

Beschreibung

COLL_BODY_ROBOT 0;1 Aus-/ Einschalten Kollisionsprifung alle
Bodies gegen alle Roboter
COLL_BODY_TOOL 0;1 Aus-/ Einschalten Kollisionsprifung alle
Bodies gegen alle Tools
COLL_ROBOT_TOOL 0;1 Aus-/ Einschalten Kollisionsprifung alle
Roboter gegen ihre Tools
COLL_GRAB_BODY_BODY |0;1 Aus-/ Einschalten Priifung alle
gegriffenen Bodies gegen nicht
gegriffenen Bodies
COLL_GRAB_BODY_ROBOT |0; 1 Aus-/ Einschalten Kollisionspriufung alle
gegriffenen Bodies gegen alle Roboter
COLL_ROBOT_ROBOT 0;1 Aus-/ Einschalten Kollisionsprufung
Roboter gegen sich selbst
COLL_BODY_BODY 0;1 Aus-/ Einschalten Kollisionsprufung
Bodies gegen sich selbst
COLL_LINE_ENABLE 0;1 Aus-/ Einschalten der Kollisionslinie
COLL_DETECCODE 0;1;2 Auswabhl des Collision Detection Codes
0 - Zellen ohne Kollision laden
1 - OpCode (nur x86)
2 - PQP ,A Proximity Query PackageA
TEXT SIZE 12 Andert die SchriftgroRe fir allgemeine
Texte und Tags (2. Parameter)
1-TYPE 10 SEMIBOLD ARIAL
bis
8 - TYPE 24 SEMIBOLD ARIAL
WORLD_COORSYS 0;1 Aus-/ Einschalten des
Weltkoordinatensystems
TAG_COORSYS 0;1 Aus-/ Einschalten des Pfade und Tags
ROBOT_COORSYS 0;1 Aus-/ Einschalten der
Roboter-Achs-Koordinatensystems
ROBOT_BASE_COORSYS 0;1 Aus-/ Einschalten des
Roboter-Basis-Koordinatensystems
BODY_COORSYS 0;1 Aus-/ Einschalten des

Bodykoordinatensystems

Technische Anderungen und Verbesserungen sind vorbehalten

12/109

EASY-ROB Software GmbH Hauptstr.42 65719 Hofheim am Taunus Germany Tel. +49 6192 921 70-77 Fax. +49 6192 921 70-66 info.er@easy-rob.com www.easy-rob.com



mailto:info@easy-rob.com
http://www.easy-rob.com/

™ EASY-ROB

(]
N 3D Robot Simulation Tool

Environment Variablen

Kommando und Syntax

Gultige Werte

Beschreibung

ROBOT_TCP_COORSYS 0;1 Aus-/ Einschalten des
Roboter-TCP-Koordinatensystems
IPO_COORSYS 0;1 Aus-/ Einschalten des temporéren IPO

Koordinatensystems

CRUISE_ROT_FLAGS

LMB; MMB; RMB, SHIFT, CNTRL

Taste flr Rotation der Welt

CRUISE_ZOOM_FLAGS

LMB; MMB; RMB, SHIFT, CNTRL

Taste flr das Zoomen

CRUISE_ZOOM2MB_FLAGS

LMB; MMB; RMB, SHIFT, CNTRL

Falls ,2 Mouse Button“ im Aux menu ->
.Mouse Mode* deaktiviert ist; alternative
Mdglichkeit zum Zoomen

CRUISE_PAN_FLAGS

LMB; MMB; RMB, SHIFT, CNTRL

Verschieben der Arbeitswelt

CRUISE_ROT_FLAGS_2

LMB; MMB; RMB, SHIFT, CNTRL, UNDEF

Alternative: Taste flir Rotation der Welt

CRUISE_ZOOM_FLAGS_2

LMB; MMB; RMB, SHIFT, CNTRL, UNDEF

Alternative: Taste flir Zoomen

CRUISE_PAN_FLAGS_2

LMB; MMB; RMB, SHIFT, CNTRL, UNDEF

Alternative: Taste flir Verschieben

CRUISE_COMMON_FLAGS

DEFAULT

Filtert Cruise Mouse Button

DLG_TRANSPARENCY

0x1001 alpha;
0x1002 alpha;
0x1004 alpha;
0x1008 alpha;
0x1010 alpha;

Legt den Voreinstellungswert fiir die
Transparenz der Dialoge fest.

OFF: 0x1001

Low: 0x1002

Medium; 0x1004

High: 0x1008

User: 0x1010

alpha = 100-255

Technische Anderungen und Verbesserungen sind vorbehalten
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EA SY'ROB ™ Bedienungshinweise
System Dateien

Konfigurationsdatei: config.dat

EASY-ROB™ hendtigt eine Konfigurationsdatei fiir den Start. Die Konfigurationsdatei "config.dat" wird
automatisch bei jedem Start von EASY-ROB™ geladen und enthalt Informationen zu:

- dem Pfad / Speicherort der Lizenzdatei "license.dat"

- dem Pfad zu den ,temporéren Dateien”

- dem Pfad zu den ,Benutzerdateien®

- Bibliothekspfade und DLL-Namen, bei Nutzung der API-User DLL Option
- Bevorzugten Editor

Mit einer “eigenen” Konfigurations-Datei kann jeder Bediener das EASY-ROB™ mit den ,eigenen®
bevorzugten Einstellungen starten und nutzen.
Anderungen in der Datei konnen durch manuelles Editieren vorgenommen werden.

Um die Datei zu editieren kann der Bediener
den Tastenkombination verwenden : “Alt+Shift+C”

oder das Menl nutzen: File menu ->Edit-> EASY-ROB System files-> ,Config file*
Anmerkung:

Ein Ausrufezeichen (! ) am Anfang einer Zeile in der Systemdatei steht fur eine Kommentarzeile. Sie
kdnnen jeglichen Kommentar in diese Zeile schreiben — sie wird bei der Ausfuhrung ignoriert.

Technische Anderungen und Verbesserungen sind vorbehalten 14/109
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Config File

Kommando und Syntax

Gultige Werte

Beschreibung

sind erlaubt

LICENSE= A\ Pfad fiir das License-File
Default ist der Zielordner der Installation
oder komplette Pfadangabe “c:\Programme\EASY_ROBY
ch....\...... \
(siehe auch Details LICENSE unten)
TMPDIR= Absolute und relative Pfadangaben | Beinhaltete Dateien:
sind erlaubt .
- moni_msg.txt
- HardwareNumber.dat
Beispiel fur Pfadangabe:
TMPDIR=%USERPROFILE%\EASY-ROB\tmp
Default ist der Zielordner der Installation
USRDIR= Absolute und relative Pfadangaben | Beinhaltete Dateien:

- easy-rob.pth (neue Datei)

- easy-rob.env

- easy-rob-localizationx64.ini

- er_LoadFromLibPb.ini

- er_LoadFromLibPb_prefered.ini

Beispiel fur Pfadangabe:
USRDIR=%USERPROFILE%\EASY-ROB

Default ist der Zielordner der Installation

LIBRARY_PATH=

Absolute und relative Pfadangaben
sind erlaubt

Pfad fiir den Ort der UserDLL'’s

Beispiel:

A aktueller Ordner

A ein Ordner Uber aktuellem
Ordner

“c:\home\my_er” absoluter Pfad

Default: LIBRARY_PATH= .\

(siehe auch Details APl User DLL unten)

z.B.. notepad, notepad++, ...

USER_DLL= “<name> <start option> <comment | Name der UserDLL
string>”
(siehe auch APl User DLL unten)
EDIT= Jeder ausfiihrbare Editor Variable zum Setzen des bevorzugten Editors.

Beispiel:

EDIT=notepad

oder

EDIT= C:\program files\vim\gvim

Default: EDIT= notepad

Technische Anderungen und Verbesserungen sind vorbehalten
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Config File

Kommando und Syntax

Gultige Werte

Beschreibung

HELPFLN=

Ahelp.erh

relatives Verzeichnis des help files

ER_KIN_DLL=

er_kinx.dll

API-KIN, Benutzerdefinierter Name fir

vorwarts und inverse Kinematik

X =, bei EASY-ROB™ x86 Version

X = ,x64" bei EASY-ROB™ x64 Version
x = ,dII“ bei EASY-ROB™ DLL Version

x = ,dlIx64" bei EASY-ROB™ DLL x64

ER_IPO_DLL=

er_ipox64.dll

API-IPO, Benutzerdefinierter Name fir
Bewegungsplanung und Ausflihrung

ER_DYN_DLL=

er_dynx64.dll

API-DYN, Benutzerdefinierter Name flr
Dynamik und Steuerung

ER_POST DLL=

er_postx64.dll

API-PostProcess, Benutzerdefinierter Name

fir PostProzessor

ER_SENSOR_DLL=

er_sensorx64.dll

Benutzerdefinierter Name fiir Sensor-
Integration

USR_OWNERKEY_DIR=

Absolute und relative Pfadangaben
sind erlaubt

Verzeichnis der OwnerKey Datei

USR_OWNERKEY_FLN=

Absolute und relative Pfadangaben
sind erlaubt

Name der OwnerKey Datei

Technische Anderungen und Verbesserungen sind vorbehalten
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Config File

Details zur Variable “LICENSE” in Config file
Jedes EASY-ROB™ Produkt (Ausnahmen sind DEMO- und VIEWER-Version) benétigt eine Lizenz zum
Starten.

Diese Lizenz ist eine Textdatei mit dem Namen "license.dat" und wird beim Kauf ausgehandigt.
Wahrend der Standardinstallation wird die Lizenzdatei automatisch in das Standard-Zielverzeichnis kopiert.

Beim Start von EASY-ROB™ sucht das Programm zundachst in der Config Datei nach dem Pfadangabe der
Lizenzdatei. Danach priift EASY-ROB™ in dem gegebenen Pfad die Lizenz auf Giiltigkeit.
Anmerkung:
Bei der Standardinstallation wir die Lizenzdatei in das Standard-Zielverzeichnis kopiert:
C:\ Program Files \ EASY-ROB\

wobei die EASY-ROB™ Software in folgendem Pfad installiert wird:
C:\ Program Files \ EASY-ROB \ EASY-ROB x64 \

Aus diesem Grund ist der Defaultwert fir die Variable:

LICENSE= ..\

Achtung:

Wenn Sie nicht die Standardinstallation durchfiihren oder wenn Sie nach der Installation die Pfade manuell
verandern, mussen Sie die Variable fur die Lizenzdatei in der Konfigurations-Datei Uberprifen und ggf.
anpassen.

Technische Anderungen und Verbesserungen sind vorbehalten 17/109
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Config File

Details zu den Variablen “LIBRARY_PATH” und “USER_DLL"“ im Config file

Mit der Option API-UserDLL kann EASY-ROB™ individuell per API an die Bedirfnisse angepasst werden.
So koénnen eigene Bediendialoge entwickelt und bei jedem Start von EASY-ROB™ automatisch aufgerufen
werden.

Die Information fir EASY-ROB™, welche UserDLL geladen werden muss, befindet sich auch im Config file.
Die Variable fir die Pfadangabe heil3t “LIBRARY_PATH” und gibt das Verzeichnis an, in dem die UserDLL
abgelegt ist.

Beispiel: LIBRARY_PATH= .\

Absolute and relative Pfadangaben sind erlaubt:

A aktueller Ordner

A ein Ordner Uber aktuellem Ordner
c:\home\my_er” absoluter Pfad
“Wws01\my_er” absoluter Pfad

Die Variable fir den Namen der UserDLL ist “USER_DLL” und hat 3 Parameter.

1. der DLL Name- z.B. "er_vad_exp0O1.dll"
2. ein Ziffer fur die Startoption

”1” startet den Dialog sofort beim Start von EASY-ROB™

"0" erfordert den manuellen Start des UserDLL-Dialogs Uiber View Menu-> API UserDLL Dialoge
3. ein Benutzerdefinierter String als Kommentar

Beispiel: USER_DLL= er_vad_exp01.dll 1 Api UserDIl Expl_01
USER_DLL= er_vad_exp02.dll 1 Api UserDIl Expl_02

Anmerkung:
Falls Sie die API-UserDLL’s nicht im Standardverzeichnis ablegen, miissen Sie sicherstellen, dass alle
anderen DLL'’s (die von der UserDLL bendtigt werden) auch gefunden werden kénnen.

Technische Anderungen und Verbesserungen sind vorbehalten 18/109
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EA SY'ROB ™ Bedienungshinweise
System Files

Lizenzdatei: license.dat

Die Lizenzdatei ,license.dat” enthalt einen einmaligen Lizenzschlissel fiir das entsprechende Produkt mit
Ablaufdatum.

Zum Ansehen der Datei 6ffnen Sie diese Uber das Menii:
File -> Edit-> EASY-ROB System files-> ,License file*

oder mit der Tastenkombination : “Alt+Shift+L”

Technische Anderungen und Verbesserungen sind vorbehalten 19/109
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EA SY'ROB ™ Bedienungshinweise
System Files

Monitoring Message Datei: moni_msg.txt

Die Datei ,moni_msg.txt“ protokolliert die allgemeine Systeminformation wahrend einer EASY-ROB™
Session.

Dies sind Informationen wie z.B.:
- das ,working directory“
- Datum und Zeit
- Lizenzdatei
- alle freigeschalteten bzw. gesperrten Optionen
- Verzeichnis der Environment Datei und Config Datei

Diese Datei kann dem EASY-ROB-Support-Team auch beim Support helfen.
Im Fall eines Problems kdnnen Sie die Monitoring Message Datei fur die Analyse zusammen mit der
Supportanfrage an EASY-ROB schicken.

Um die Datei anzusehen 6ffnen Sie diese Uber das Meni:
File -> Edit-> EASY-ROB System files-> ,moni_msg file*

oder mit der Tastenkombination : “Alt+Shift+M”

Tipp:

Im Fall von extrem zeitaufwendigen Informationsausgaben wie z.B. beim Laden einer Arbeitszelle mit
extrem vielen Tagpunkten, kann man die Environment Variable MONI_MSG_OUTPUT in der Datei “easy-
rob.env” ausschalten [0].

Technische Anderungen und Verbesserungen sind vorbehalten 20/109
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System Files

Bevorzugte Pfade Datei: er_LoadFromLibPb_prefered.ini

Bevorzugte Pfade

Zusatzlich zur automatisch erzeugten Pfadhistorie im Device Manager werden im selben Pulldown-Meni(
auch so genannte ,bevorzugte Pfade” zur Verfliigung gestellt. Die ,bevorzugten Pfade“ werden vom
Bediener manuell angelegt, in dem er in der Datei ,er_LoadFromLibPb_prefered.ini“ seine

bevorzugten Pfade angibt.

Diese Datei wird einmalig vom System angelegt, falls sie nicht existiert. Im Unterschied zu der automatisch
erzeugten Pfadhistorie, bleiben die ,bevorzugten Pfade® unverandert und ermdéglichen dem Bediener so
einen schnellen Zugriff auf seine 12 wichtigsten Pfade.

Die Pfade missen wie in dem untenstehenden Beispiel komplett angegeben werden.
Zeilen, die mit einem Ausrufezeichen beginnen werden als Kommentar gewertet.

Beispiel:

This file contains all your prefered/favorite paths

All lines starting with "!" will be ignored

Maximum numbers of paths is 12

:\Program Files\EASY-ROB\ApplicationLib

:\Program Files\EASY-ROB\DeviceLib

:\Program Files\EASY-ROB\RobotLib

:\Program Files\EASY-ROB\Tutorial\Proj example erpl

——aaaa -

Um die Datei zu editieren, 6ffnen Sie diese Uber das Mend:

File -> Edit-> EASY-ROB System files-> ,er_LoadFromLibPb_prefered.ini*

Technische Anderungen und Verbesserungen sind vorbehalten 21/109
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System Files

Working Pathes File: easy-rob.pth

Details zu den Variablen “WORKDIR* und ,,IGPDIR “ im Working Pathes File

Damit Anwender lhre eigenen Arbeits- und Geometrieordner festlegen kénnen, welche ggfs. von den
Benutzerordnern abweichen, wurden die Pfade fur diese Ordner aus der config.dat herausgetrennt und
werden zukinftig in der neuen Datei “easy-rob.pth” verwaltet.

Hier kdnnen Pfade flr die Arbeits- und Geometrieverzeichnisse mit

- WORKDIR=
- IGPDIR=

festgesetzt werden.

Um eine gute Ubersicht zu behalten wird empfohlen alle Projekte in separaten Bibliotheken zu speichern
und in diesen wiederum eine bestimmte Ordnung einzuhalten.

Die Datenhaltungs-Philosophie in EASY-ROB™ basiert auf 2 Verzeichnissen.
Dem ,working directory“/ ,Arbeitsverzeichnis“ (WORKDIR) und dem ,3D CAD Verzeichnis® (IGPDIR).

Das ,working directory” (WORKDIR) enthalt:
- Zelldateien (*.cel)
- Roboterdateien (*.rob)
- Programmdateien (*.prg)
- Views (*.vie)
- Text (*.txt),
- Bitmaps (*.bmp)
- Daten (*.dat)
- JPEG (*jpg)

Das 3D CAD Verzeichnis (IGPDIR) enthélt alle 3D Geometrien wie:
- “igp
- *stl
- il
- *stp
- *3ds

Technische Anderungen und Verbesserungen sind vorbehalten 22/109
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Working Pathes File

Details zu den Variablen “WORKDIR* und ,,IGPDIR “ in Working Pathes File

Damit EASY-ROB™ die entsprechenden Parts/Teile einer Arbeitszelle finden kann, miissen die
WORKDIR-Pfade und IGPDIR-Pfade in der Working Pathes File deklariert werden.

Beispiel:
WORKDIR= .\ApplicationLib\ArcWelding
IGPDIR=..\ApplicationLib\ArcWelding\igp

Mittels dieser Pfadangaben ,weil3“ das System wo die entsprechenden Teile, Programme und Roboter fir
eine bestimmte Zelle zu finden sind.

Note:
Absolute und relative Pfadangaben sind erlaubt:

A aktueller Ordner

A ein Ordner Uber aktuellem Ordner
“‘c:\home\my_er” absoluter Pfad

\\wsO01\my_er absoluter Pfad

Wichtiger Hinweis:

Eine EASY-ROB™ Zelle- bzw. Roboterdatei (.cel/.rob) enthalt lediglich den Dateinamen (plus Endung) von
einer 3D CAD Geometrie, aber nicht den Inhalt!

Um eine angegebene Datei auf der Festplatte, dem Memorystick oder im Netzwerk zu finden, sucht EASY-
ROB™ in allen definierten IGPDIR-Pfaden. Standardmafig sucht EASY-ROB™ auch im Unterordner mit
dem Namen ,.\igp“ der geladenen Zell- bzw. Rob-datei.

Kommando und Syntax | Giltige Werte Beschreibung
WORKDIR= Absolute und relative Pfadangaben | Pfad fur das ,Working directory“
sind erlaubt Beispiel:
A aktueller Ordner
A ein Ordner Uber
aktuellem

Ordner
“c:\home\my_er” absoluter Pfad
“Ws01\my_er” absoluter Pfad

(siehe auch Details WORKDIR unten)

IGPDIR= Absolute und relative Pfadangaben | Pfad fiir die ,3D CAD Geometrie*
sind erlaubt Beispiel:
A aktueller Ordner
A ein Ordner Uber
aktuellem
Ordner

“‘c:\hnome\my_er” absoluter Pfad
“Ws01\my_er” absoluter Pfad

(siehe auch Details IGPDIR unten)
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Lokalisationsdatei: easy-rob-localizationx64.ini

Details zu den Variablen “en-US*, ,,de-DE“ und ,,zh-Hans*

Die Lokalisation erfolgt unter dem Menipunkt
,Datei > Edit > EASY-ROB Systemfiles > Localization Datei*
und wird durch ausklammern der nichtgewiinschten Sprachen mit einem ,!“ vor den Zeilen:

- en-US fiur Englisch
- de-DE fir Deutsch
- zh-Hans fur Chinesisch (traditionell)

erreicht. Auf der nachfolgenden Seite wurde in der Lokalisationsdatei die deutsche Sprache aktiviert.
EASY-ROB 3D Robot Simulation Tool
EXE - Simulation Version x64
Localization file

"easy-rob-localizationx64.ini"

Allowed language keys are

|
!
|
!
|
!
!
!
! Make sure that the localization Dlls exist
|
!
!
! en-US ==> EasyRobwx64ENU.dll (english)

! de-DE ==> EasyRobwx64DEU.dl1l (german)

! zh-Hans ==> EasyRobwx64CHS.dll (chinese)

|

!

Note: '!'" or ';' comment a line
|

len-US
de-DE

!zh-Hans
|

EASY-ROB™ sucht dabei nach folgenden Lokalisation-DLLs im Installationsverzeichnis:

- EasyRobwx64CHS.dII
- EasyRobwx64DEU.dII
- EasyRobwx64ENU.dII

Sollten die Lokalisation-DLLs nicht vorhanden sein, startet EASY-ROB™ mit Englischem GUI, was die
Standardeinstellung ist.
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Erste Schritte mit EASY-ROB™

Aufbau einer einfachen Arbeitszelle mit Roboter und Werkzeug

Unsere einfache Arbeitszelle soll vorerst aus einem Roboter mit einem Werkzeug bestehen.

8l EASY-ROB 3D Robot Simulation Tool H
Laden eines Roboters
Load 3 Cell file Ctrl+O O -'
o o | Nach dem Start von EASY-ROB™

Robot file

wird Uber das Menu File / Load

o” R o ] Robot file aus dem Verzeichnis
= —_— —_— »-\Easy-Rob\TrainLib“ der Roboter
sichten = Meuer Ordner
. . robot.rob geladen.
Linkfavoriten Name Anderungsdatum Typ GroBe
| Dokumente |1aR . .
5l Zuletzt besuchte Orte _‘:)::zl;::a\ — Der RObOter ISt nun IMm
B Deskiop [ ——— Hauptfenster von EASY-ROB™ zu
S [Qorentischrce sehen. Es handelt sich um einen
B g i [ = Knickarmroboter mit sechs
— || pue asnaen e B=  Achsen, also um einen typischen
ra uchvergange | jtorch_U4.ro | .
| " Industrieroboter.
Bl orener . Laden eines Werkzeugs
Datsiname: ~ | |Open Robet (*rab) -
Offnen Abbrechen

Analog wird Uber Menii File / Load
Tool file das Werkzeug tool.tol
geladen.

Sichern Sie nun den Zwischenstand in dem Sie im Meni File / Save Robot file unter dem Dateinamen
robot_tool.rob speichern. (Hinweis: Die Endung *.rob wird automatische hinzugeftgt)

Hinweis: Die Dateien mit der Endung .rob kénnen sowohl Informationen tber den Roboter als auch tber
das verwendete Werkzeug enthalten.

Tipp: Wie Sie es aus anderen Anwendungen gewohnt sind, kdnnen Sie Dateien zum Laden auch direkt aus
dem Windows® -Explorer in das EASY-ROB™-Hauptfenster ziehen (Drag’n‘Drop).
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Erste Schritte mit EASY-ROB™

Navigieren in der Arbeitszelle und Bewegen des Roboters

Mittels der rechts dargestellten Symbole, wird in der Arbeitszelle navigiert bzw. der

Roboter bewegt. Das erste Symbol ist der Navigationscursor mittels dem eine l!ncn'l
Bewegung in der Welt mdglich ist. Das zweite bzw. dritte Symbol erlaubt die
Bewegung des Roboters in Werkzeug- bzw. in Weltkoordinaten, wobei mit dem TCP
letzten Symbol zwischen translatorischer und rotatorischer Bewegung umgeschaltet o
wird. Mit dem Symbol Robot Joints erfolgt die Bewegung des Roboters in TCF
Achskoordinaten. WORLD
Hinweis: Machen Sie sich mit den einzelnen Funktionen vertraut, in dem Sie diese L]
auswahlen und dann im Hauptfenster von EASY-ROB™ mit der Maus und
gedruckten Maustasten bewegen. Nutzer mit einer 2-Tasten-Maus, missen dazu im ROBOT
Menii Aux / Mouse Mode die Option 2 Mouse Buttons aktivieren und die BASE
Einstellungen mit File / Save / Environment file speichern. 7]
0P
Tipp: Mit einem Doppelklick auf die einzelnen Symbole werden erweiterte Funktionen
zuganglich.
Erweiterung der Arbeitszelle durch Hinzufliigen eines Werkstucks
II:MclcslmlacmiD—[) Tags View Aux 7 AuSWahl der CAD-Gruppe
Select Group s
zf:‘t‘;j::::jf;im . . 3D-CAD-Daten werden in EASY-ROB™ in drei
=) Gruppen gegliedert.

Select Body Group m

TPl G =] [ance Die Robot Group beinhaltet alle Daten, die den

e —— Roboter betreffen (z.B. die Roboterbasis oder

4t den Roboterflansch).

[ Double Click to select Item or Action

In der Tool Group finden sich alle Daten wieder,
die dem Werkzeug zuzuordnen sind.

Werkstiicke und alle weiteren Geometrien der

) Curent selected lem Arbeitszelle sind in der Body Group
1| 2-Body Group . . . . ..
: - i eingeordnet, welche wir mit Hilfe des MenUs
CAD Preview Settings 3D-CAD / Select Group / Body Group
Open CAD-Import Window aUSW&h|en.

Open 3D-CAD Window

Hinweis: EASY-ROB™ ist kein 3D-CAD-System, sondern ein Roboter-Simulationssystem. Nur einfache
Geometrien wie beispielsweise Quader, Zylinder, Kegel und Kugeln kénnen in EASY-ROB™ erzeugt
werden. Daher muss die Modellierung komplexerer Geometrien generell in 3D-CAD-Systemen erfolgen. Die
Geometrien kdnnen dann in EASY-ROB™ importiert werden. Um eine effiziente Simulation zu ermdglichen,
sollte der Detaillierungsgrad fur die Robotersimulation reduziert werden. Es ist aus Grinden der
Performance verstandlicherweise nicht sinnvoll hier ,jede Schraube® darstellen zu wollen.
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Erste Schritte mit EASY-ROB™

Hinzufugen des Werksticks

Durch Auswahl des Menlpunkts 3D-CAD /
Create/Import new 3D CAD Body / CUBE wird in der
Arbeitszelle ein Quader erzeugt.

Die rdumliche Lage des Koérpers wird spater
festgelegt.

Setzen Sie nun die Lange des Korpers (X) auf 200
mm, die Breite (Y) auf 300 mm und die H6he auf 550
mm.

i

1% 1.000000<=| 2000000 | <=1000000.0000
2 1000000 <= 3000000 | <= 1000000 0000
3 Height 1.000000 <=| 5500000 | <=1000000.0000 £.000000

Positionieren des Werkstlicks

Um das Werkstiick zu positionieren, wahlen
Sie aus dem 3D-CAD Meni den Untereintrag
Enter Positions / World Position.

Der EASY-ROB™-Frame-Dialog bietet unter
anderem die Mdglichkeit die rAumliche Lage eines
Kdrpers in 6 Freiheitsgraden zu definieren.

Setzen Sie den Kdrper wie abgebildet auf die
Position X=450 mm, Y=300 mm und Z=0 mm.

Technische Anderungen und Verbesserungen sind vorbehalten

Fil EASY-ROB 3D Robot Simulation Tool

File Robotics Simulation | 3D-CAD | Tags View Aux 7

Select Group
Select Body from Group
Create/Import new 3D CAD Body
Resize cBody

Set Jnt_Idx for Robot Group.

B
2-FYRAMID
3-WEDGE
4-CYLINDER

8- 5TL ascii o binamy FILE
9-3D-Studio FILE
10- Quit

Current selected ltem
1-CUBE

Open 3D-CAD Window

Current selected 'Sting' Value

Mame: -» BOX

Geben Sie dem Korper anschliel3end den
Namen BOX.

fil EASY-ROB 3D Robot Simulation Tool
File Robotics Simulation [3D-CAD | Tags View Aux ?

v @ 2

Select Group

Select Body from Group

Creste/Import new 3D CAD Body

Resize cBody

Set Int_Idx for Rebot Group

Grab/Release Body to/from Robot Tip

Clene

Atributes >
Color

Name

Clear

Reference Position
Offset Position
Reference * Offset Position

Enter Positiens

=

Waild Pasiion VBL0 [mm/deg] World Pasition
Arow Up

w EI R, 00000 I P Relative Position
¥ 300000 gy 00000 Gifllpdate

z 0000 Ry 00000

Dist 540.833 Paste

EASTROBRWFRz =
dst 100000 gr 30000 -Satment
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Andern der Farbe des Werkstiicks

Um die Farbe des Korpers zu andern, wahlen Sie den Menipunkt 3D-CAD / Color.

F8 EASY-ROB 3D Robot Simulation Tool C:\prog\EASY-ROB\TrainLib\box.cel
File Robotics  Simulation LUl Tags View Aux 7
NN Select Group
‘ % @ @ | Select Body from Group
i Create/Import new 3D CAD Body
Resize cBody
Set Int_Idx For Robot Group
GrabfRelease Body toffrom Robot Tip

Clone
Attributes

Clear
Enter Positions
Show curent 3D CAD Coorsys

vai Select Color

| 7-LIGHTGRAY

| 8- DARKGRAY

|9- LIGHTBLUE

|10 LIGHTGREEN
|11 - LIGHTCYAN
|12-

Rey

255 255 255

’ Current selected Item

14 -YELLOW

Speichern der aktuellen Positionen

Speichern Sie die aktuellen Positionen aller _ (. ot
sich in der Arbeitszelle befindenden Korper | s
(Roboter und Werksttick) als Startpositionen, S iy i 7
in dem Sie im Menu Simulation / Save Start Condition Sav sition and Joints as Start Condition  Ctr+-Al+Shift+S
COI’]dItIOﬂ / Save a” Robots POSItIOI’]S and TCFT'.frace ONJOFF SavecRuhotJuintPositionasStartCo.r!ditiun

R .. L. Collision ONJOFF Save cRobot Reference to Start Condition
Joints as Start Condition auswéhlen. RED-BLUE Colision ONJOFF | Save cRohot Base Position as Start Condition

Dynamics ONJOFF Save cRobot Tool Position as Start Condition

. . . . . Simulation Dat Save all cRobot Body Pasitions as Start Conditi

Mit den restlichen Funktionen in diesem Menu opwroriw ot Save o Tl By Poskonsas Sttt Conen.

k 0 nnen auc h nur b e Stl m mt e P 0s |t| onen Increase/Decrease Steps | Save all Environment Body Positions as Start Condition
einzelner Bauteile gespeichert werden. i bt it e

Save all Path Positions as Start Condition

Tipp: Zum Zuriicksetzen der Korper in diese
Position verwenden Sie das Meni Simulaion/
Reset Start Condition/ Reset all Positions and
Joints as Start Condition

Technische Anderungen und Verbesserungen sind vorbehalten 28/109
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Erste Schritte mit EASY-ROB™

Speichern der Arbeitszelle

P8l EASY-ROE 3D Robot Simulation Tool

Speichern Sie den aktuellen Robotics  Simulation 3D-CAD  Tags View Aux 7
Bearbeitungsstand als Arbeitszelle unter Load
dem Dateinamen ,box.cel“in dem Sie im Save Cell file Ctrl+5
Meni auf File / Save Cellfile klicken. Unload Cell file Export

et Robot file

Select preferred Directories Tool file

Wenn man die folgende Abfrage ,Reset
all Positions and Joints to Start
condition® mit “Ja” bestatigt, wird alles
auf die Startposition zurtickgesetzt. (Das
sind die Positionen, die wir im vorigen _
Schritt gespeichert haben) 3/ Reset all Positions and Joinks to Start condition?

Achtung:
Wenn man die Positionen nicht [ Ja ] [ M ]
gespeichert hat und dennoch mit ,Ja“
bestatigt, kann dies zu unerwiinschten
Positionsanderungen fiihren, die nicht
mit einem Knopfdruck riickgangig
gemacht werden kdnnen.

Wenn man die Abfrage mit ,Nein* _

bestatigt, hat man nach der Eingabe des :.5) Save all current Pasitions and Joints to Start condition?
Namens der zu speichernden Zelle noch

die Moglichkeit die derzeitigen
Positionen als Startwerte zu speichern [ Ja ] [ Mein ]

Hinweis: EASY-ROB™-Arbeitszellen
(Dateien mit der Endung .cel) enthalten
alle Informationen tber Roboter,
Werkzeug und Werkstiicke sowie
Verweise auf etwaige
Roboterprogramme.

Tipp: Arbeitszellen kbnnen ebenfalls
durch die Auswahl des
Diskettensymbols aus .

der Symbolleiste @
gespeichert werden.

Tag: PATHOL:T_S World Cruise Trans  Abs NUM

Technische Anderungen und Verbesserungen sind vorbehalten 29/109
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Setzen von Arbeitspunkten (Tag-Punkte)

Tag-Punkte (Teach-Punkte) beschreiben unter anderem die M Tag Window E=t000
raumliche Lage, also Position und Orientierung, von - _— -
Arbeitspunkten, welche vom Roboter anzufahren sind. o e i e i

u|13 /1thPATHU1 :onB:01 Tag
Hinweis: Das Tag-Fenster wird durch einfachen | .sEL | aRel Pth] [r:l:engCP Teg A
Mausklick auf das Symbol SEL TAG aufgerufen. ' TAG ' 2

[ Re Attach ] [cTaglo TCP]
[ Path |[wiobi| |Prefix|[Name)|

An jede der vier oberen Ecken des Quaders soll jeweils ein Tag- (Delete cPath| [ Delete cTag |

Punkt erzeugt werden (Nr. 2 bis 5). Zusétzlich soll ein Tag-Punkt [~ wiabj pose

(Nr. 1) als Anfahrpunkt definiert werden.

Aufgabenstellung:

¥ 0000 R 0000
Y 0000 P 000D
z

0oo0 Y 0.000

Motion type
Save ] [ Reset ] © Default
Name #- WOBJ( & @ PTP
Path Owner - Disabh ) LN
Attach to Jnt. Ref_Woarl o
Wobj. Pos. 00001

Ori. > 0.0°0.0°0.0 Mousetode Tag

b [ Refresh |

[T1TCPJog  [|ShowcTag [ |Measure

[] Show Test Connect [7] Show Path
no Tags
Vorgehensweise zur Erzeugung der Tag-Punkte
Klicken Sie einmal auf den Knopf New TCP Tag. Dadurch wird ein
Tag-Punkt an der Werkzeugspitze (Tool Center Point: TCP) " 450 Rz 0.000
erzeugt. Der Tag-Punkt wird in der Tag-Auswabhlliste erscheinen. e ann Ry 180
z 700 Rz 0.000

Setzen Sie nun die Position des Tag-Punktes T_1 auf X=450 mm,
Y=300 mm, Z=700 mm und die Orientierung des Tag-Punktes auf
Rx=0 Grad, Ry=180 Grad und Rz=0 Grad.

Save ] [ Rezet

Aktivieren Sie nun das Kontrollkéstchen TCP Jog unten im TagWindow, der Roboter wird nun zum ersten
Tag-Punkt springen, d.h. das TCP-Koordinatensystem und das Tag-Koordinatensystem werden in Deckung
gebracht.

Klicken Sie nun nochmals auf New TCP Tag um den Tag-Punkt T_2 zu erzeugen. Dieser liegt

Deckungsgleich mit T_1. Verschieben Sie den Tag-Punkt T_2 auf die Héhe von Z=550 mm. Tag-Punkt T_2
liegt nun auf der ersten Ecke des Quaders.
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Erzeugen Sie nun den Tag-Punkt T_3 und setzen die Y-Koordinate auf 600 mm. Danach erzeugen Sie den
T_4 mit der X-Koordinate 650 mm. AbschlieRend wird der Tag-Punkt T_5 erzeugt, welcher auf Y=300 mm

liegt

Zur Kontrolle enthélt nachfolgende Tabelle nochmals die raumliche Lage aller fiinf Tag-Punkte:

Tag X [mm] Y [mm] Z [mm] Rx [deg] Ry [deg] Rz [deg]

T1 450 300 700 0 180 0

T2 450 300 550 0 180 0

T3 450 600 550 0 180 0

T4 650 600 550 0 180 0

T5 650 300 550 0 180 0
Tipp: Zur einfacheren Positionierung kénnen Sie die
Funktionalitdt des EASY-ROB™-Formel-Parser nutzen. Falls ein w 450000 R 0.000
Tag-Punkt, der in der Ho6he von Z=700 mm liegt, beispielsweise : :
auf die Héhe 550 mm verschoben werden soll, geben Sie ¥ 300000 Ry 180000
einfach im Z-Feld 700-150 ein. z 700450 | Rz 0,000

Stimmt die Lage lhrer Tag-Punkte mit denen in der Tabelle 5 ave ] [ Fieset

Uberein, so fahren Sie den Roboter in die Home-Position und

speichern Sie den momentanen Arbeitsstand unter dem
Dateinamen box_tags.cel als Arbeitszelle.

w11 4
afobi
Mew | |73

T 4
elete 75
harie
elete

ase
00D

Hinweis: Die EASY-ROB™-Arbeitszelldateien beinhalten auch die erzeugten
Tag-Punkte. Darliber hinaus wird beim Speichern die momentane Stellung des
Roboters als Ausgangsstellung definiert.

Tipp: Um die Tag-Punkte entsprechend der Listenreihenfolge automatisch
anzufahren, wéhlen Sie den ersten Tag-Punkt und Klicken Sie auf Move Along.
Mit welcher Bewegungsart die einzelnen Tag-Punkte angefahren werden sollen,
definieren Sie mit dem Knopf Motion type im TagWindow.

b otion type
@ Default
I PTP
LM

Tipp: Die Reihenfolge der Tag-Punkte kann mit der Up und Down Buttons
verandert werden.
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Erzeugen eines PTP-Roboterprogramms in EASY-ROB™

Offnen Sie zunéchst das TeachWindow

T Teach Window PRG_PTP.PRG_

durch Mausklick auf das entsprechende [:l_% Smulation ERPL-ERCL Settings ?

SymbOI' [ Reload ][ E ditci ][ Hew ][Save as][ Save ][ Load ][Llnload]
Erzeugen Sie ein neues Programm durch Klick auf

den Knopf New. Dann speichern Sie das Programm 20 |[Inset || Del |[UrDel || Copy J[ Paste || bodiy |
durch Klick auf Save as im TeachWindow unter dem ( Find |[>][*#1 ROBOT_TOOL' > PRG_PTRPRG | [EditPrg
Namen prg_ptp. Sichern Sie die Zelle unter dem Pragram 'PRG_PTP.PRG' loaded to 'ROBOT_TOOL
Namen box_prg_ptp.cel. PTP_tix | ProgramFils ~

| cRobot ROBOT TOOL'

. ) | Below section is caled ance at t=0
Hinweis: Der Name des EASY-ROB™-Programms I Add Initialization commands here
AN P f : |
wird in der Arbeitszelldatei gespeichert. Das Fick | Endinit
Programm wird dann beim néchsten Laden der Zelle I I

I Below section is called at b0
lAdd new ERPL / ERCL commands here

m

automatisch aktiviert.

|

SPEED_FTP_OV 20.0000
SPEED_CP_0v  80.0000
SPEED_ORI_0Y 20.0000
ACCEL_PTP_OY 100.0000
ACCEL_CP OV 100.0000
ACCEL_ORI_OY 1000000
ov_FRO 100.0000

Umbenennen des Unterprogramms

Die PTP-Bewegungsvorgaben (Point-to-Point) sollen
in einer Funktion mit dem Namen sub_ptp abgelegt

werden. Holen Sie durch einen Doppelklick die bl ERT NO_DECEL OFF

Programmzeile call my_fct_name() in die Edit-Zeile ZONE "~ 0.0000

des TechWindows und &ndern Sie diese in call i

sub_ptp(). Durch einen Druck auf die Return-Taste ;:all MyhaveFct])

wird die editierte Zeile in das Roboterprogramm S RUN || EndPragramFile

Ubernommen. Andern Sie nun den Namen der PigStep || e 0

i A i R : ot MM ovebo

Funktion, d.h. andgm Sie die Programmzeile :-| e

fct my_fct_name() in fct sub_ptp(). [Fugwin | o HOME i
ERCElisadiaiy  Hinweis: Programme kénnen in EASY-ROB™ sehr komfortabel durch Mausklicks
S A 2 erzeugt werden. Die einzelnen Programmbefehle lassen sich in die Gruppen
[ Motion, Cntrl und ERC einteilen. Verschaffen Sie sich eine Ubersicht durch Klick
el [ auf die entsprechenden Knopfe im TeachWindow (> Motion, > Cntrl, > ERC).

[Find J[>] | 't ROBOT' - 'B0X_PRG_F
P:;m:x Pragram B%_PRE_PTP_LIN E|nf[_]gen der Bewegungsbefeh|e far PTP
o, ProgramFile
:C:DD‘:\IDL‘EF;DIDBI’TD;ICEE ance 1 i i U a i i
(Al e Befehle werden immer vor der aktuellen Zeile eingefiigt. Wahlen Sie daher die

Pek - Endr letzte Programmzeile endfct aus. Zuerst soll der Roboter in die Home-Position

lBdowsectin s caledatbt fahren. Flgen Sie den Befehl Home 1 durch klicken auf den Home-Knopf im Teach

1 Add ERPL /ERCL . .
e o] “" Window zu dem Unterprogramm hinzu.

Move

|
EndProgramFile

T T Offnen Sie nun das TagWindow und wéhlen Sie den ersten Tag-Punkt T_1.
[ (Gie) Lm;pp Dricken Sie nun den Knopf PTP cTag im TeachWindow (cTag steht fir current
EE?% Tag, d.h. fir den momentan ausgewahlten Tag-Punkt).

PTP T4 . . . . .
— e Verfahren Sie ebenso mit den weiteren Tag—Punkten T_2 bis T_5. Figen Sie
TP T abschlieend noch Verfahranweisungen zu T_2, zum Anfahrpunkt T_1 und zur

EndFet Home-Position hinzu.

Speichern Sie das Programm durch Klick auf den Save-Knopfim TeachWindow.
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Ausfihren des Programms

Das Programm wird durch Klick auf den Run-Knopf gestartet. Die
Simulationsgeschwindigkeit kann mittels des Decrease Stepsize- (Ctrl + Shift + -) und

> D

des Increase Stepsize-Knopfs (Ctrl +) angepasst werden.

Tipp: Um das Programm unendlich oft abzuspielen, driicken Sie auf den Repeat-Knopf.

1

anzeigen lassen.

& &

Hinweis: Den TCP-Trace kénnen Sie sich durch Klick auf den Show Robot TCP Trace-Knopf

Erzeugen eines LIN-Roboterprogramms in EASY-ROB™

Control Commands

T Teach Window PRG_PTP.PRG

g

Simulation ERPL-ERCL Settings 7

411 ROBOT_TOOL' > PRE_PTPPRG!

)

Home | Program PRG_PTP.PRG' loaded ta 'ROB

a7_T(

PTP_4& | | ProgramFil

e e

| cRobot'ROBOT_TOOL

| Below section is called once att=0
| &dd Iritialization commands here

|

Endlrit
|

| Below section is called at ts0)

SPEED_PTP_Ov 80.0000
SPEED_CP_Ov 200000
SPEED_ORIOY 800000
ACCEL_FTP_OV 100.0000
ACCEL_CP_OV 100.0000
ACCEL_ORI_OY 100.0000
0% _FRO 100.0000
ERC WO _DECEL OFF

| Add rew ERPL ¢ ERCL commands here
|

Cntrl Commands 7
Robat
[ 7oL

[ Set Default SPEEDs and ACCELs |
SPEED_

CONFIG |

[ PIRax | [ PTROV |
[ e ][ crov ]
[ om ][ oRov |
ACCEL

[ ACcsET | [(AUTODACEEL |
[ PRax | [ _PTROV |
[ ce [ crov |
[ oR | [ oRLOV |

I ation Planner Settings
[ =zowe | [ DECEL |
IFTP Calc Mode] [ Leading Type ]

3 String Input Dialog

LUNOR | [ CRCORL |

Enter Name of CALL Function

K
Cancel

todo?

A

igram Contral Statements
LT 4[| ENDFCT| [LIF (.. ENDIF |
CALLFCT | [ WHILE(.. |

ait for Signal
)

| Comments 7] Keepopen

Close

Cunent selected ‘String' ¥ alug

Fet-Name: -» my_fct_name()

Speichern Sie das Programm zunéchst mittels des
Save as-Knopfs im TeachWindow unter dem
Namen box_prg_ptp_lin.prg ab. Speichern Sie
dann die Arbeitszelle unter dem Namen
box_prg_ptp_lin.cel.

Hinzufligen des Unterprogramms fur
LIN

Das Unterprogramm mit den Verfahranweisungen
fur LIN soll vor dem Unterprogramm mit den PTP-
Anweisungen aufgerufen werden. Wahlen Sie
dazu die Programmzeile mit dem Befehl call
sub_ptp() aus. Dricken Sie dann im TeachWindow
den Knopf >Cntrl und wéhlen Sie im néchsten
Auswabhldialog den Knopf CALL FCT. Geben Sie
als Funktionsnamen sub_lin() ein. Wenn Sie die
Frage im nachsten Dialogfeld mit ja beantworten,
so fugt EASY-ROB™ automatisch eine
Unterfunktion ein.

Einfugen der Bewegungsbefehle fur
LIN

Wahlen Sie die Programmzeile endfct, welche die
Funktion sub_lin() abschliel3t aus.

Flgen Sie die Befehle Home 1 und PTP T_1
hinzu, da der Roboter zunachst in die Home-
Position fahren soll um dann den ersten Punkt
mittels einer PTP-Anweisung anzufahren.

Wahlen Sie nun die Punkte T_2 bis T_5 im TagWindow aus und klicken Sie nach der Auswabhl jeweils auf
LIN cTag im TeachWindow. Vergessen Sie danach nicht die Punkte T_2 und T_1 ebenfalls mit LIN-
Anweisungen anzufahren. AbschlieBend wird der Roboter in die Home Position gefahren.

Denken Sie daran, das Programm mittels des Save-Knopfs im TeachWindow zu speichern.

Technische Anderungen und Verbesserungen sind vorbehalten
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Simulation ERPL-ERCL 7
[ Feload ][ E ditar ][ Mew ][Save as][

(110 ][Jnsen | [CDel_] [urpel] |
'#1 ROBOT' -» 'B0X_PRG_F
Pragram 'BOR_PRG_PTP_LIM
m ProgramFile

[T [y || cFebet RoBOT!

| Below zection is called once
1 &dd Initialization commands
|

Endinit
|

I Below section is called at t>
! &dd new ERPL / ERCL con

5 RUM F‘TF'T 2
FraStep ﬁTP T'I1

EndFct

Technische Anderungen und Verbesserungen sind vorbehalten

el
E IIC

—

FCT sub_linf)
Home 1

So sieht das fertige Programm fur LIN- und PTP-
Verfahranweisungen aus.

Tipp: Mit dem > Run Cmd-Knopf aus dem TeachWindow
kénnen einzelne Verfahranweisungen ausgefiihrt werden
(Einzelschritt-Modus). Markieren Sie hierzu die
entsprechende Programmzeile mit einem Mausklick und
drucken Sie auf > Run Cmd.

Vergleich des Bewegungsverhaltens bei
PTP und LIN

Vergleichen Sie das Bewegungsverhalten des Roboters
in dem Sie den Trace einschalten und einmal das
Unterprogramm mit den PTP-Verfahranweisungen
ausfuhren und dann das Programm mit den LIN-Befehlen
mittels des Einzelschritt-Modus ausfiihren. Wechseln Sie
nach dem PTP-Unterprogramm die Trace-Farbe auf blau.
Hierzu wahlen Sie im EASY-ROB™-Hauptmeni den
Eintrag View / TCP Trace / Color / Color for desired TCP
TRACE.
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Anpassung der Verfahrgeschwindigkeiten und Verfahrbeschleunigungen

Achten Sie darauf, dass die Bewegungsplaner fur
PTP-, CP- und CIRC-Verfahren jeweils auf Jerkfree

F8l EASY-ROB 3D Robot Simulation Tool c\program files\easy-rob\trainlib\box_prg_ptp.cel
File | Robotics | Simulation 3D-CAD Tags View Aux 7

Select Robot

cRebot Tool Data
cRobot Ext Tcp Data
cRobot Base Position
cRobot Attributes

cRobot Program

cRobot Kinematics
cRobot Dynamics

cRobot Motion Planner
Applications

Ctrl+K

Open Kinematics Window

ROBOT_TOOL Select Jaint Planner

Controller
Mation Planner Data
External TCP

Ipo Joint Code API-IPO
Ipo CP Code APLIPO

1 - Geometric Yel-Prof. C0
o rof. C3

3-ipo_jnt_userl
4 - ipo_jnt_uzer2
5 - ipo_jnt_uzer3d
E - ipo_jnt_userd
T - ipo_jnt_userd
8 - ipo_jnt_userf
9 - ipo_jnt_user?
10 - ipo_jnt_uzerd
11 - ipo_jnt_ugzerd
12 - ipo_jnt_uzerld
13- _uzerll
14 - ipo_jnt_ugerl2
15 - Guit

Current selected ltem
2-Jetk free Vel-Prof. C3

ON/OFF

Vel-Prof. C3 eingestellt sind. Diese Einstellung
kdnnen Sie im Menl Robotics / Robot Motion
Planner vornehmen.

Hinweis: Bei der Auswahl des Bewegungsplaners
und der Festlegung von Geschwindigkeiten wird
zwischen PTP und CP unterschieden. CP bedeutet
Continuous Path, also Bahnfahren wie LIN oder
CIRC.

Speicher Sie das Programm mit dem Save as-Knopf
im TeachWindow unter dem Namen
box_prg_ptp_lin_speed.prg ab und sichern Sie die
neue Arbeitszelle unter dem Namen
box_prg_ptp_lin_speed.cel.

Einstellen von SPEED und ACCEL

Mit dem > Cntrl-Knopf aus dem TeachWindow
erhalten Sie Zugriff auf die Befehle zum Setzen von
Geschwindigkeiten und Beschleunigungen (SPEED
und ACCEL).

; : - Control Co d
Setzen Sie die Werte fur SPEED und ACCEL durch e T B
.. . ntrl Commands 7
Auswabhl der entsprechenden Knopfe wie i Hoot
nachstehend aufgefuhrt: [ foor ] [_cowms |
Simulation ERPL-ERCL Settings
deg [Rclosd | (Edior | [ New | [Saveas [ Save ||| [ SetDefault SPEEDs and ACCELs |
ACCEL_ORI 40 — SPEED_
S (#20 ][[Insert ][ Del |[UrDel ][ Copy |
m ind ][] [0 ADBOT_TODL - #RG_PPeRg| | PR | [ PTROV |
ACCEL CP 1.500 — Program PRG_PTPPRG badedord| P | [ POV ]
- SZ I3 | — [ o] [ oRLOV |
cHobot 'ROEBD QoL
d | Eelows section is called ance at t=0 ACCEL
eg :Add\n\lializaliun commands here [ AEI_ESET ] [ AT ACTEL ]
SPEED_ORI 5 — Ertr Coe e
_ ‘ » X
S 1 Below section s called st 50 [ e | [ crov |
| Add new ERPL / ERCL commands hi [ ee ] [ R ]
m SPEED_PTPOV 00,0000 =
SPEED _CP 0.050 — <)) | SPEED TP Tv 500000 Mation Planner S ettings
- SPEED_ORI_OW B0.0000
S ACCELPTPLOY 1000000 [ =Zowe | [ DECEL |
QEEEEEPHTDS’V yDDDDDDDDDDDD [PTF Calc Mode | [ Leading Tupe |
deg Ov_PRO 100.0000 [ un_orl | [ CIRC_ORL |
ACCEL_PTP_AX 4040404040 ——— ERC NO_DECEL OFF
_ ! 40 Sz ZONE 0.0000 Program Control Statemertts
z A [FCT s ENDFCT] [[IF (... ENDIF |
deg i gall MyMaveFel) [ calLFcT | [ WHILED.. |
SPEED_PTP_AX 5.05.05.05.0 — EndProgramFile
50 50 SZ Biosten Fit Mybd oveFct) “wiait for Signal
Home HOME1
Prawiin || PTPT 1~
[C] Comments [7] Keepopen
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Erste Schritte mit EASY-ROB™

<z [ estended

curent Maotioh D ata v

mm angegeben.

SimStep 100.0 s 5
SimTine 07:21 [m|n] T|me 13578 (3]
Faobat Time 07: 21 [min] - Sigwhait 0.0
curr. Time B.837 [¢]

lpoStep 10.00 [me]

Owerride 100 [%]

Speed PTP 5.00 [degs]
Speed CP - 500000 [mm's]
Speed ORI 5.00 [deg/s]
Accel PTP 40.00 [degts™2]

Accel CP 150000 [rmmds™2]

Accel ORI 4000 [degds™2]
Leading POS 0K . )
Zone 0.1 Beschleunigungswerte angezeigt.

Usge Tag attributes OM
Mo Deceleration OFF

Erweiterung des Programms

Speichern Sie das Programm diesmal unter dem Namen
prg_ptp_lin_speed_track.prg und die Arbeitszelle unter dem
Namen box_prg_ptp_lin_speed_track.cel.

Veranderung des Tracks aus dem
Roboterprogramm

Die Darstellung des TCP Trace kdnnen Sie direkt aus dem EASY-
ROB™-Roboterprogramm ein- und ausschalten. Darliber hinaus
kénnen Sie die Farbe des Tracks beeinflussen. Fiigen Sie einfach
die gelb hinterlegten Zeilen in das Programm ein. Dazu klicken
Sie den Knopf > ERC im TeachWindow und wéahlen die Option
ERC [] ON. Klicken Sie danach auf TRACK. Zur Wahl der Farbe
wahlen Sie die Option ERC COLOR []. Nach Auswahl von
COLOR TRACK wahlen Sie die entsprechende Farbe.

Einfligen einer Programmpause

Zeitlich befristete Programmunterbrechungen kénnen durch den
WAIT-Befehl gefolgt von der Zeitangabe in Sekunden in das
Programm eingefligt werden. Der néachste Befehl wird dann erst
nach Ablauf der festgelegten Zeit ausgefiihrt. Bei der Zeit handelt
es sich um Simulationszeit nicht um Echtzeit.

Tipp: Probieren Sie den Effekt indem Sie das Programm einmal
mit einem WAIT Befehl und einmal ohne WAIT-Befehl durchlaufen
lassen und sich die Simulationszeit ansehen. Programmzeilen
kénnen Sie durch ein vorangestelltes Ausrufezeichen
auskommentieren.

Technische Anderungen und Verbesserungen sind vorbehalten

Verifikation des Ergebnis

Hinweis: Im Gegensatz zu den SPEED- und ACCEL-Dialogen werden
im EASY-ROB™-Roboterprogramme die LAngenangaben in m statt in

Rufen Sie Uber die Symbolleiste den Robot 10 Output-Dialog auf und
wahlen Sie aus der Liste den Eintrag current Motion Data. Sie erhalten
unter anderem Informationen tber die Dauer der Simulation, die Dauer
des Roboters im Einsatz und die Dauer des letzten Bewegungssatzes.
Dariiber hinaus werden die aktuellen Geschwindigkeits- und

W

[ Reload ][ E ditar ][ Mew ][ﬁave as][ Save ][ Load
ACCEL_PTP_#x  40.0000 40.0000 40.C
[#51 1] ][ Inzert ][ Del ][ LInDeI][ Copy ][ Faste

#1 ROBOT' -> 'bow_pra_ptp_lin.prg' *
Frograrm 'bow_pra_ptp_lin.pra’ loaded to 'ROEC
r'rogramFliIe .
! EEIDDEvD_tS_ch‘_:EDEnDiI called once att=0
i Add Iritislization commands here

Fick | Endlnit

| Below zection is called at >0
| &dd new ERPL / ERCL commands here

|
[<BIE) accer o anoono
ACCELCP 1.5000
SPEED_CP  0.0500
PTF|[Ln] SFEED ORI 50000

E irc AEEEL PTP_&% 40.0000 400000 40.C

- SPEED_PTP_ 4% 50000 50000 500
> Motion |

» Critrl |EHE TRACK OM |
ERC COLOR TRACK, GREEM
> EHC ub linl
|WA 5.0000
5 FILIN ERC COLOR TRACE. BLUIE
F'rgStep

caII sub_ptp(]

m E ndProgramFile
Fo
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EA SY'ROB ™ Bedienungshinweise
Short Keys und Start-Optionen

Die EASY-ROB™ Bedienoberflache kann mit der Maus und tber die Tastatur durch sogenannte Shortkeys
bedient werden. Die folgende Liste gibt einen Uberblick.

EASY-ROB™ - Start mit option und Kommando-Liste

Beispiele:

easyrobw.exe .\proj\Zelle.cel -run -io Ladt die Arbeitszelle "Zelle.cel", startet das mitgeladene
Programm automatisch und 6ffnet das Online Ausgabefenster
fur die Achswinkel des Roboters oder der NC Maschine.

easyrobw.exe -remote -info Offnet nach dem Starten den Remote Control Dialog und das
Message Fenster automatisch.

easyrobw.exe -toolbarsoff - statusbaroff Startet ohne Toolbars und Statuszeile

easyrobw.exe -loadlib Offnet den Load Bibliothek Dialog, Button

easyrobw.exe -prog -teach Offnet das Program- und Teach Window

EASY-ROB™ Bedienoberflache

Eile Robotics  Simulation

v e (s C £

DD Toowr

A D HEE PN

Select Robot Toolbar

[ #1-smspa-260-3.1

3% s (Vo e & d(llle @ 4 ¢

[lview 21 xyz 10751140 1174, « cRobot: #1 SMS-PAL-260-3.1 Move World Cruise _ Trans Abs NUM

COMAU Roboter SM5-PAL-260-3.1
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Short Keys und Start-Optionen

Button oder Menu

Tastenkombination/
Option

Funktion

Open avi recorder dialog

F6 Open AVI recorder
dialog

Startet AVI Recorder Dialog

Toggles: Simulation View

b Toggle Light -light 3D Szene ohne Lichtquelle darstellen

ﬁ Toggle Point, Vertices -C;)tgli:t P 3D-Geometrien in Punkte-Darstellung

B Toggle Wire Frame (\:/\t/r:; w 3D-Geometrien in Drahtmodell-Darstellung
D Toggle BBox %SO; B 3D-Geometrien in bounded Boxes

Q Toggle Backface Culling _Cbtfr;;reShift +B Backface Culling

@ Toggle Floor -flooroff Zellenboden aus

<3 | Floor Position -floorwire Zellenboden dargestellt im Drahtmodell
&

=

>

or CAD-Preview Ctrl + Tab Wechsel: Simulation und Preview
Run Program Sg:: R "Run" Start Programm
ﬂﬂ ii * Pause/Continue Fortsetzen/ Anhalten des Programms
i Abort Program Programm-Abbruch
Stops program execution Automatischer Programm-Stop nach jedem
Pl after each motion .
Programmierbefehl
command
F-) Repeats program -runrepeat Automatische Programmwiederholung
automatically
% 3D Animation On/Off AI§t|V|eren/Dea!<t|V|er§n der 3D-Animation
wahrend der Simulation
% Decrease Stepsize Ctrl + '+' Simulations-Schrittweite verringern
ﬁ Increase Stepsize Ctrl + Shift + *-' Simulations-Schrittweite erhéhen

Technische Anderungen und Verbesserungen sind vorbehalten
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Short Keys und Start-Optionen

Display miscellaneous
output values

-i0 -i02 -i03 -io4

Offnet die ersten 4 Ausgabe Fenster
(desired Joint Values, desired Cart. Pose,
current Motion Data, actual Joint Values)

Button oder Menu

Tastenkombination/
Option

Funktion

{2 File > Load > Cellfile

Ctrl + O
-loadcel

Laden/6ffnen einer Arbeitszelle

File > Load = Robot file

-loadrob, -loadrobot

Offnet Dialog zum Laden des Roboters

File = Load - Tool file

-loadtol, -loadtool

Offnet Dialog zum Laden des Tools

@ File > Load - Load from | Ctrl + Shift + O Laden von Zellen, Robotern, Tools, etc. aus
Library -loadlib der Bibliothek, Visual File Interface
F'Ie. ~ Load > Start Ctrl + Shift + P Startet den Projektmanager
Project Manager
File > Load > Start Ctrl + Shift + S Startet den ERC Searcher
ERC Searcher
F|.Ie > and > Start Ctrl + Shift + H Startet History Diagram
History Diagram
File > Load - Start .
CAD2ER Converter Ctrl + Shift + C Startet CAD2ER Converter
@ File > Save - Cellfile |[Ctrl+S Speichern/ Speichern unter der Arbeitszelle
File > Unload - Cell Ctrl + U Entladen der Arbeitszelle
F!Ie - Edit 9 EASY'ROB System Alt + Shift + C Editieren der Datei config.dat
Files > Config file
File - Edit > EASY-ROB System . L . _
Files > Environment file Alt + Shift + E Editieren der Datei easy-rob.env
F!Ie > Ed.lt > EA.SY_ROB System Alt + Shift + L Editieren der Datei License.dat
Files - License file
F!Ie ~ Edit 9 EASY.'ROB System Alt + Shift + M Editieren der Datei moni msg.txt
Files > Moni_msg file -
. . Ctrl + F4,
File > Exit Alt + E4 EASY-ROB beenden
? = Online Help F1 Online Hilfe aufrufen
? = License Info -licenseinfo Lizenz Information
? > About... -about Offnet Dialog "About"
Simulate > Programs >
Teach Window " .
Iﬁ Open Prgram Teach -teach Offnet Teach Dialog
Window
_ Simulate > Programs >
@ Progam Output -prog Offnet Program Dialog
Show Program Window
f::i (2x) Tags > Tag Window tag Offnet Tag Dialog

Technische Anderungen und Verbesserungen sind vorbehalten
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Short Keys und Start-Optionen

nim (2x) 3D-CAD -> 3D-CAD |-3dcad Offnet 3D-CAD Dialog
Window
Button oder Menu TasFenkombmann/ Funktion
Option
Koordinatensysteme in den Achsen des
Roboters anzeigen
View - Coorsys >
E Show Robot Coorsys -robcoorsys -
-
View > Message Window Ctrl + M, Offnet Mgssage Dialog
-message (!nformatlonsausgabe)
View > Navigator Window Ctrl + N Offngt Navigator Dialog (Pick & Click,
Abstédnde messen, etc.)
View > Status Bar -statusbaroff Programm-Statuszeile aus
View > Coorsys - Show Robot -robCOOrSYS Koordinatensysteme in den Achsen des
Coorsys y Roboters anzeigen
Offnet Avi-Recorder Dialog
VH Avi Recorder = ‘
Setting |
) Initialize
View - EASY-ROB Plugin Dlls > .
: -avi
Avi Recorder
current Avi Window Size 1280 % 720 Ratio 17.8:10 [ Show |
Recorded Frames 0 (0.0s), take each 1. frame E
Toggle ON/Off m
[V Menu [ Toolbars [¥] Status line o
View = Show Toolbars 2> All Ctrl+T .
Alle Toolbars ein
Toolbars On -toolbaron
View = Show Toolbars 2> All Ctrl + Shift + T Alle Toolbars aus
Toolbars Off -toolbaroff
View = Show Toolbars = -toolbarloadsaveoff Alle Toolbars aus
Load/Save
View = Show Toolbars 2 Render -toolbarrenderoff Render Toolbar aus
V'e.W 9 Show Toolbars > Run/ -toolbarrunoff Run Toolbar aus
Animation
View = Show Toolbars > On/Off -toolbaronoffoff On/Off Toolbar aus
View = Show Toolbars > 3DCAD -toolbar3dcadoff 3D CAD Toolbar aus
View-> Show Toolbars-> Move -toolbarmovetooff Move to Toolbar aus
Robot to
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View = Show Toolbars - Mouse

-toolbarmouseoff Mouse Move Toolbar aus
Mode
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Short Keys und Start-Optionen

Button oder Menu Tas"[enkombmatlonl Funktion
Option
View Show Toolbars = Robot -toolbarselectrobot Roboter Toolbar aus
Toolbar
Robotics > Robot Application > | F2 Remote Control Dialog starten
Remote Control -remote
Robotics - Robot Application > F3 )
External Devices > Sensor Offnet Sensor Interface Dialog
-sensor
Interface
View - EASY-ROB Plugin Dlis ;
VImI97 Export F7 Startet VRML97 Export Dialog
View 9 Set SD V|.ews > Goto Ctrl + Tab Zur ndchsten Simulations-Ansicht schalten
next Simulation View
View 9 Set .3D V|_ews > Goto Ctrl + Shift + Tab Zur vorherigen Simulations-Ansicht schalten
prev Simulation View
3D CAD = Attributes = Info Crl + 1 G_(_aometnelnformatlon des aktuellen CAD
Korpers
3D CAD - Cad Preview Settings . Geometrieinformation des CAD Kérpers in
Ctrl + Shift +I '
- Info der PreView
Mouse Mode Toolbar =
@ e worto s Spacebar/ Leertaste , _
me & mwm Q Toggelt zwischen dem vorherigen und dem
P T @7 TCP aktuellen "MouseMode"
COORD  JOG - TOOL
Wiouse Mode Toolbar E <> WorldView <- Jog Robots TCP Tool
T e ro o osor TCP @ Jog Robots TCP Tool <-> WorldView
mAdEwe oot
oo s A = zon «>
= - - i —
Aux - EASY-ROB Client Window | -client Offne_t €in We_ltere EAS.Y ROB Sltzungz
wobei die gleiche Arbeitszelle geladen wird.
Trncn'l Ist der Mouse-Modus "Tcp Tool" aktiv, kann
wahrend der Mausbewegung durch Driicken
Aux > Mouse Mode > TCP Tool MouseMode der Shift- und/oder Crtl-Taste auf
Aux > Mouse Mode > Abs | Rel absolute/r_elatlve Bew_egung bzw.
_ e translatorisch/ rotatorisch umgeschaltet
Aux - Mouse Mode—> Rot | Trans shitt = LOORD werden.
=y Status-Zeile |T1ans |Rel
i _—
Citrl > —
Technische Anderungen und Verbesserungen sind vorbehalten 43/109

EASY-ROB Software GmbH Hauptstr.42 65719 Hofheim am Taunus Germany Tel. +49 6192 921 70-77 Fax. +49 6192 921 70-66 info.er@easy-rob.com www.easy-rob.com



mailto:info@easy-rob.com
http://www.easy-rob.com/

™ EASY-ROB

(]
N 3D Robot Simulation Tool

TCP )
Aux = Mouse Mode > TCP World MouseMode | worin Ist der Mouse-Modus Tcp World" aktiv,
kann wahrend der Mausbewegung durch
. = Driicken der Shift- und/oder Crtl-Taste auf

Aux > Mouse Mode > Abs | Rel | Shit > : absolute/relative Bewegung bzw.

Aux > Mouse Mode=> Rot | Trans translatorisch/ rotatorisch umgeschaltet

Ctrl EN ABS werden.
CODRD
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Short Keys und Start-Optionen

Button oder Menu

Tastenkombination/
Option

Funktion

Aux = Mouse Mode - Joint

M JogWindow (ke e
dnt1to3 Joint LME Jnt.

o i3 o 13

46 © 1
9 02
7 1012 ) Rotate P 3
([ PickRobot ) [ Cuise | MouseMode ESC setzt die Achswinkel zuriick
Double Click a Cmd to Run from List
T ——— o Mit der Ctrl-Taste wird wahrend der
LN_Rel000 0 150 Mausbewegung auf die Achsen 4-6
LIN_Rel 000 150 0 geschaltet. Beim Loslassen wieder auf die
LNCAe000 00 15 - ESC Achsen 1-3.
% | enter a command
Ctrl ROBOT
o Zweimaliges Klicken auf | **™™ | startet den
2 JOINTS JogWindow Dialog
Aux - Mouse Mode - World _ _
View Ist der Mouse-Modus "World View" aktiv,
kann durch Driicken der TAB-Taste in die
; Sl Kameraperspektive umgeschaltet werden
M+ Navigator... | MouseMode und Zur[rj)ck p g
File View Mouse Mode '
&b ESC setzt die ,3D-View* zuriick
[ Pick &Click | [ Camera | #
ESC Zweimaliges Klicken auf startet den
LHE erd View, Navigator Dialog (Pick & Click, Abstande
@ Rot Pan () Zoom messen etc.)
Cruise Mode
picked Paint_ v | [¥] COI Im Navigator Window kann der Cruise Mode
festgelegt werden, um den die 3D Szene
gedreht wird.
S e —— Wird zuerst die Ctrl-Taste, wird der Cruise
: : Mode auf Robot TCP gesetzt. Somit ist der
aktuelle Drehpunkt der TCP des Roboters.
“Wiord Co
= chobat B Ctrl-Ke . o
- EHEb; TESPE y Wurde zuvor mit Pick & Click ein Punkt,
current Body Polygon oder Tag ausgewahlt und es soll
E‘E&Ed Foaint um diesen Punkt gedreht werden, so
drucken Sie die Shift-Taste. Der Cruise
Mode wird auf ,picked Point” gesetzt und
2x @ Shift-Key bestimmt den aktuellen Drehpunkt der 3D

Szene..

Technische Anderungen und Verbesserungen sind vorbehalten
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Short Keys und Start-Optionen

Tastenkombination/

Button oder Menu ; Funktion
Option
Aux - Mouse Mode - Trans/Rot
current selected Tag
= Tag Window Mﬁ
File Move Attributes Manipulate View
#1/1 PATHO1:WOBJO1 Tag Ist der Mouse-Modus "Trans/Rot current
ECall cTag | selected Tag" aktiv, kann wahrend der
h Mausbewegung durch Dricken der Shift-
e Attacl clagto .
und/oder Crtl-Taste auf absolute/relative
. .
SEL Bewegung bzw. translatorisch/ rotatorisch
one e
TRG umgeschaltet werden.
[Dele!e cPath] lDelele cTag] . -
B MouseMode Durch Driicken der Pfeil Hoch/Runter Tasten
X 0000 R 0.000 kénnen die Tagpunkte selektiert werden.
S on It oo . ABS Der Name des aktuellen Tagpunktes wird in
hi > ; .
Z 000 Y 0000 Shift L der Statuszeile angezeigt.
[ J [ ] Motion type
Save Reset © Default
Name B WOBJ( .| CFTP Ctrl N & Tag: PATHOL:T_1
Path Owner - Disabh LN T——
Attach to Jnt. Ref_Worl = .
Wobi.Pos. 00001 Taste <Pos 1> selektiert den ersten
Oi->  00°0.0°00 | MoussMode Tag Tagpunkt, Taste <Ende> den letzten
Pick| [Poly Arrow UP
Tagpunkt des Pfades.
Shap to Poly Arrow Down
= — (Bstesn] Pos 1 (home) Absolut: Bewegung bzgl. Wobj-Frame
Elaas s s Relativ: Bewegung im Tag-Frame
[ Show Text V] Connect [ Show Path Ende (end) ) gung g
no Tags . . ..
L ESC ESC setzt die Tag Position zuriick
SEL 2
X TAG

EASY-ROB™ Status-Zeile

Ready

World Cruise Trans Abs NUM
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EA SY' RO B ™ Bedienungshinweise
Allgemeine Funktionen

Positionierung des FuRBbodens

Einige Maschinen haben den Nullpunkt im EASY-ROB-Weltursprung. Bisher konnte man entweder den
FuRboden unsichtbar setzen oder den Maschinennullpunkt verlegen, damit die Maschine ,auf dem Boden
steht” und nicht ,darin®.

Mit der aktuellen Version kénnen Sie die Position und die Orientierung des systemeigenen Fuf3bodens in
EASY-ROB frei variieren bzw. definieren und somit an die Bedurfnisse anpassen.

Uber das Menii ,View | Floor | Floor Position® rufen Sie den Frame Dialog auf.

-
I+ Frame Dialog

Floor Position [mm/deg]

[
% 0000 Ry 0.0000

Y 0000 Ry 0.0000 GrfUpdate

Z -300.000 |Rz 0.0000

Dist. 300.000 Paste

EASYROBRsRyRz  v| [ Copy |

dist 100000 gr 90.000

Frame T2 [ absal.
Frame - +dx
3.5 0000 E Boden verschieben
el in X, y oder z- Richtung
5-hs_0.0000
Boden verdrehen
e 1.000000 + - um X, y oder z- Richtung
Swap|[T2*T1|[1T1*T2

iT2*T1|iT1*T2

Undo
iny

@
@
=
N

Siehe hierzu auch das Kapitel ,Frame Dialog*
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EA SY' RO B ™ Bedienungshinweise
Allgemeine Funktionen

TCP TRACE

Bei der Darstellung der Spur des Tool Center Points gibt es unterschiedliche Varianten. So kann neben der
Art, der Farbe und der Starke auch der ,Befestigungspunkt® verandert werden.

Zu den Settings gelangen Sie Uber das Menu View | TCP Trace |

Wies EETra—

Set 3D Views 3 @ ‘ " ii
Render Y G = TCP Trace ein- bzw.
Floor r ausschalten
TCF Trace 4w TCF Trace CIMJOFF
Camera J T , | — Anderung Typ
ype
Coarsys » .
ol » | <4«— Anderung Farbe

Show | Hide OMJOFF ¥ ° ':'rth is X 9

) ength and Size . . .
Open Online Cutput Data ra— — Anderung Lange / Starke

arafic Yiew Data

Anderung
Ursprung/Befestigungspunkt

W TCP Trace CNIOFF TCP Trace ein- bzw. ausschalten

v Line Einstellung Typ:
Calor b Paint Line Trace wird als Linie angezeigt
Length and Size ¥ Line + Z Approach Direction Point  Trace wird als Punktlinie angezeigt
Reference Z Approach Direction Line + Z Linie und Approach-Achse in Z
% Approach Direckion Z App. Approach-Achse in Z
¥ Approach Direction X App. Approach-Achse in X

Y App. Approach-Achse in'Y

Length and Size 4 Color For dynamics TCP Trace
Reference |

Calar Color For desired TCP Trace | Auswahl der Farbe fiir den TCP Trace

Irm-
Select Track Color

-~

o, =

3 - CYAN
4-RED
5 - MAGEMTA
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TCP TRACE

Length and Si

TCP Trace Ling thickness
TCP Trace Approach length
TP Trace Point size

Reference

78 Enter tcp trace line width z
1 [m] 1000000<=| 30000 | <=5.0000

¥8 Enter tcp trace approach length Z
1 [m] 0.001000<=| 0100000 | <=1.000000

‘

¥ 8 Enter tcp trace point size

Anderung der
- Starke des TCP Trace

- Approach Lange des TCP Trace

Punktstarke des TCP Trace

1 [m] 1.000000<=  2.0000 | <=5.0000
Reference

Bl

2 - Robat aze
3 - Rabat Jaint to do 7
4 - quit

Auswahl des Befestigungspunktes des TCP
Trace

Mdglichkeiten:
- bezogen auf den Weltenursprung
- bezogen auf Roboterbasis
- bezogen auf ein bestimmtes Gelenk

Technische Anderungen und Verbesserungen sind vorbehalten
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EA SY' RO B ™ Bedienungshinweise
Allgemeine Funktionen

Kollisionsprufung in EASY-ROB™

Mit der Kollisionserkennung in EASY-ROB™ kénnen unterschiedliche Objekte in der Arbeitzelle auf
mogliche Kollision geprft werden.

Es kénnen einzelne Objekte oder Gruppen gegeneinander gepriift werden. So kann man z.B. nur die
Achsen 5 und 6 eines Roboters gegen den Schutzzaun prufen, wenn man genau weif3, dass alle anderen
Achsen aufgrund ihrer Verfahrwege den Zaun sowieso nicht erreichen kénnen.

Diese Minimierung der Anzahl der zu prifenden Bauteile verkiirzt die Berechnungszeit bei der
Kollisionserkennung.

Der interne Mechanismus der Kollisionserkennung ist hierarchisch: zuerst erfolgt eine bounding box
Erkennung, bevor im nachsten Schritt auf konvex oder konkav geprift wird.

Der Kollisions-Check wird nicht nur wahrend des Programmablaufs durchgefiihrt — auch beim manuellen
Bewegen des Roboters mittels des Verfahrens des TCP oder der einzelnen Joints wird die Prifung
durchgefuhrt.

Tritt Kollision auf, wird dies durch Veranderung der Farbe der kollidierenden Bauteile oder durch Stopp der
Simulation angezeigt.

Zusatzlich zur direkten Kollisionen, kann auch auf ,Beinahe-Kollision® oder ,Mindest-Abstand” gepruft
werden. Hierzu muss ein ,Sicherheitsbereich® definiert werden — z.B. 10 mm. Wird dieser
Sicherheitsbereich unterschritten wird sofort Kollision angezeigt, obwohl noch keine echte Kollision
stattgefunden hat.

Alle Funktionen hinsichtlich der Uberpriifung auf Kollision kénnen zu jeder Zeit sowohl manuell tiber die
Buttons als auch automatisch mittels ERCL Befehlen im Programm geschaltet werden.
(siehe hierzu auch Dokument ,EASY-ROB_ERPL_DE.pdf*, Dokumentation aller ERCL-Befehle)
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Kollisionspriifung in EASY-ROB™

Um dem User groRtmdglichen Handlungsspielraum zu geben, ist der Mechanismus fir die
Kollisionserkennung in 3 Ebenen unterteilt.

1. globaler Ein-/Ausschalter Kollisionspriifung
2. vorgefertigte Kollisionsketten

Mittels Ein- oder Ausschalten von vorgefertigten Kollisionsketten kann der User die einzelnen
Gruppen gegeneinander prifen. Im einzelnen sind das folgende Kollisionsketten:

BODY_ROBOT — pruft die Kollision zwischen Body und Roboter
BODY_TOOL — pruft die Kollision zwischen Body und Tool
ROBOT_TOOL — pruft die Kollision zwischen Roboter und Tool

GRABBODY_ROBOT - prift die Kollision zwischen ,gegriffenem® Body und Roboter
GRABBODY_BODY - priift die Kollision zwischen ,gegriffenem® und ,nicht-gegriffenem” Body
ROBOT_ROBOT — pruft die Kollision zwischen allen Geometrien in derselben Robotergruppe
BODY_BODY — pruft die Kollision zwischen allen Geometrien in derselben Bodygruppe

3. Kollisionsattribute auf Objekt-/Geometrieebene
Jedes Objekt bzw. jede Geometrie hat (neben anderen Attributen) ein Attribut mit dem Namen
,Check Collision* fur die Kollisionserkennung.
Hier kann fir jedes Objekt bzw. jede Geometrie festgelegt ob und wie auf Kollision gepruft werden
soll. Die mdglichen Parameter sind folgende:

OFF - keine Uberprifung auf Kollision fiir das Objekt
BBOX - Uberpriifung nach ,bounding boxes*
CONVEX - Uberpriifung konvex

CONCAVE - Uberpriifung konkav

Standardmafig ist die Prifung ,CONCAVE" eingestellt.

Anmerkung: Ist bei einem Bauteil BBOX oder CONVEX und beim anderen Bauteil CONCAVE
eingestellt, so wird die Prifung auf CONCAVE durchgefiihrt.

ACHTUNG:
Zu beachten ist bei der Nutzung der Kollisionsiuberprifung, dass auf allen drei Ebenen die ,Schalter” korrekt
gesetzt sind, um ein entsprechendes Ergebnis zu erhalten. Nachfolgend ein paar Beispiele:

Fall a)

Kollisions-Check eingeschaltet, Kollisionskette Body-Robot ist ,ON*, das Attribut ,Check Collision* ist ,OFF
-> auch wenn eine Kollision existiert, wird keine Kollision angezeigt, da das Attribut fur die Geometrie auf
den Wert ,OFF“ gesetzt ist

Fall b)

Kollisions-Check eingeschaltet, Kollisionskette Body-Robot ist ,OFF“, das Attribut ,Check Collision® ist
,LCONCAVE"

-> auch wenn eine Kollision existiert, wird keine Kollision angezeigt, da die Kollisionskette auf den Wert
,OFF* gesetzt ist
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Kollisionspriifung in EASY-ROB™

Eine Ubersicht der Abhangigkeiten der 3 Ebenen zur Kollisionserkennung:

COLLISION OFF

ON

v
COLLISION QUEUE OFF

BODY_ROBOT
BODY_TOOL
ROBOT_TOOL
GRABBODY_ROBOT
GRABBODY_ BODY
ROBOT_ROBOT
BODY_BODY

ALL

ON

v
COLLISION BODY

oder
COLLISION BODY_GRP

OFF

CONCAVE

oder

CONVEX
oder
BBOX

A 4

Check and Display NO Check and NO
COLLISION Display COLLISION
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Kollisionspriifung in EASY-ROB™

&

Ein- bzw. Ausschalten der Kollisionspriifung

o

Offnen des Bediendialog zum Ein- bzw.
Ausschalten der Kollisionsketten.

I Selection Dialog

Change ON/OFF status, just double click item
R,

- Stop on Limit Switch OFF

-Keep in Travel Range OFF toido 2
- Limit exceeded Joints OFF

- Stop on Cartesian Space OFF

- Stop on Speed Limits OFF

- Stop on Accel Limits OFF
- Stop on Collision OFF

- Stop on Unreach Pose OFF
0 - Collision Bodies vs. Robots ~ ON
11 - Collision Bodies vs. Tools ~ ON
12 - Collision Bodies itself OFF

13 - Collision grab Bodies vs. Bodies ON
14 - Collision grab Bodies vs. Robots ON

= D00 D U1 LN

15 - Collision Robot vs. its Tool  OFF
16 - Collision Robot itself OFF

Bediendialog zum Ein- bzw. Ausschalten
der Kollisionsketten

Mit Doppelklick auf dem Eintrag wird zwischen
ON und OFF geschaltet

Shove Marrnalz

o]

. 0.0 froml

r

p3l Selection Dialog

Collizion Check. for "DBR00_E"

1-DoNOT Check Callizion
2 -Ch Concave Collision
3 - Check Conves Collizion

4 - Check Bbawx Callizian

17 - Quit 2
Current selected Item
1 - Quit

l =gl Louuy ] ll-lt-'llb'h:rlj I.I'-'IULIISEI\'II

[ Measure Attribute ,Check Collision“ auf ,Concave” gesetzt.

Y E= #6 DES00_R ”
Attach ta Jnt. G
Scale 1.00007.0000 1.0000
Grab status Mo
Body twpe IGP Part -
Color RGB 76 VB YB & 1
Render Smooth
[revert Mo
BF aceCulling ez
Show Hame Mo

Mit Doppelklick auf dem Attribut wird der Dialog
zum Andern des Zustands geoffnet.
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EA SY' RO B ™ Bedienungshinweise
Allgemeine Funktionen

Exportieren einer Arbeitszelle

Immer wenn ein Bediener eine EASY-ROB™ Arbeitszelle z.B. per E-Mail an einen Kollegen oder Kunden
schicken mochte (jemand, der also nicht auf demselben PC oder im selben Netzwerk arbeitet) ergibt sich
folgende Frage:

“Sind alle erforderlichen Daten in der Sendung enthalten?!”

Enthalt die Arbeitszelle mehrere Devices, die wiederum aus mehreren Parts bestehen und auch noch ein
Programm dabei ist, kann es unter Umstanden sehr zeitraubend sein, sdmtliche Einzelteile
zusammenzustellen.

Die EASY-ROB™ Funktion “Export Workcell” unterstiitzt den Bediener dabei, alle Arbeitszellen-bezogenen
Daten zusammenzustellen.

Die Funktion kopiert die aktuelle Arbeitszelle und alle darin verwendeten Daten wie z.B. IGP-Dateien und
Programme in einen neuen Ordner.

1.
Laden Sie die Arbeitszelle @ oder Shortcut ,Ctrl+Shift+O*"

Spotweld_Demo.cel
mit dem Button
“Start Device Manager”

aus dem Verzeichnis:

../EASY-ROB / ApplicationLib /
Spotwelding

2.
Starten Sie tiber das Menii
File | Save | Cell File Export

den Export Load 'l e (el -
] ceifie ks

B rhek Fils
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Das Exportieren einer Arbeitszelle

3.

Setzen die Positionen zuriick und
Uberschreiben Sie die bestehende
Arbeitszelle

4,

Jetzt wahlen Sie das
Standardverzeichnis oder erzeugen
Sie ein neues Zielverzeichnis, um die
Daten zu speichern.

Der Default-Pfad ist das
Zielverzeichnis der EASY-ROB™
Installation:
C:\Programme\EASY-ROB

in einem Unterverzeichnis mit dem
Namen

“EASY-ROB\Proj-
Export\TARGET_DIR”

Bestatigen Sie hier den Default-Pfad
mit “Speichern”

-ROBAEASY-ROBMP o Export TARGET _DIF [Vl

Select or Create TARGET_DIR File () ||

5.
Bestétigen Sie die nachste Frage mit
“Ja’,

o, FRun batch file #

um das Batch file zu starten und 3 , .
somit die Daten in das gewahlte CimplEASY-ROB_SandboxEASY-ROBIExport-spobweld_demo.bat
Verzeichnis zu exportieren. to copy all relevant cell data (*.cel,*.pra,™.igp) to TARGET_DIR
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EASY-ROB Software GmbH Hauptstr.42 65719 Hofheim am Taunus Germany Tel. +49 6192 921 70-77 Fax. +49 6192 921 70-66 info.er@easy-rob.com www.easy-rob.com



mailto:info@easy-rob.com
http://www.easy-rob.com/

™ EASY-ROB

(]
N 3D Robot Simulation Tool

Das Exportieren einer Arbeitszelle

7.

Nachdem der Batchlauf
abgeschlossen ist, driicken Sie eine
beliebige Taste um die Command
Shell zu schlieRen.

EASY-ROB work cell export batch file

Batch file
*C:nProg~EASY-ROB~EASY-ROB-Export—Spotweld Demo—export.bat’

Exportet Work Gell file
*GinprognEASY-ROB~Applicat ionLibs\SpotWe lding“Spotweld_Demo—export.cel”

Cell

Dateiden? kopiert.
IGP Part
Dateiden? kopiert.
IGP Part
Dateiden? kopiert.
IGP Part
Dateiden) kopiert.
IGP Part
Dateiden) kopiert.
IGF Part
Dateiden) kopiert.
IGF Part
Dateiden) kopiert.
IGF Part
Dateiden) kopiert.
IGP Part
Dateiden) kopiert.
IGP Part
Dateiden) kopiert.
IGP Part
Dateiden) kopiert.
IGP Part
Dateiden) kopiert.
IGP Part
Dateiden) kopiert.

[ R T R N = - s

Program
Dateiden) kopiert.
Mimic

1 Datei{en? kopiert.
TARGET _DIR="C:“Prog~EASY-ROB\EASY-ROB\Froj—Exports\"
done 15 files copied
Driicken Sie eine beliebige Taste . . .

8.
Alle Arbeitszellen-bezogenen Daten
wie:

- Workcell-Datei

- Programm

- Mimic

- Parts
wurden in das gewdhlte Verzeichnis
kopiert.

C:\Programme\EASY-ROB\EASY-
ROB\Proj-Export\proj

Die Parts aller Devices befinden sich
im igp-Ordner.

2 |12 CHProgrammeEASY-ROBEASY-R OB Proj-Exportiproj

x Mame ardide  Twp
# | | I igp Dateiordner
' m spobweld. rme 1KBE MMC-Datei
m spotweld_demo,prg 2KBE PRG-Datei
H Spobweld_Demo-export.cel 43 KB CEL-Datei

Technische Anderungen und Verbesserungen sind vorbehalten
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EA SY'ROB ™ Bedienungshinweise
Dialoge & Windows

Device Manager

Der Device Manager bietet dem Bediener die Moglichkeit ohne die Arbeitszelle oder den Roboter zu laden,
in die betreffende Datei ,hineinzusehen®. Aufgrund der Gber den Device Manager bereitgestellten
Informationen kann der Bediener sofort erkennen, ob es sich um die gewiinschte Arbeitszelle oder den
Roboter handelt, und dann die Datei laden.

Neben einem Screenshot der Arbeitszelle oder des Roboters kénnen auch Informationen als Text hinterlegt
werden.

Uber eine ,Pfadhistorie“ und die Liste der ,bevorzugten Pfade“ kann der Bediener mit wenigen Mausklicks
durch den Verzeichnisbaum navigieren.

AuRerdem bietet der Device Manager die Mdglichkeit bestimmte Daten an den Project Manager zu senden.
(lesen Sie hierzu auch das Kapitel ,Project Manager in diesem Dokument)

1.
Offnen Sie den Device Manager (iber den Button
.Start Device Manager” oder mit dem Shortcut

Ctrl+Shift+0O:
P EASY-ROB Device ManagerV6.602 = |
Paste a path or use Pre-Selection (History) and press ‘Goto’
D:\Program Files (86)\EASY-ROB\RobotLib\Comau\RACER-7-140.rob =
or select the path by mouse click
&}, ProjectManagerDb | | Image | infomation i
=}~ J. RobotlLib
&~ J, ABB
[#- 1, adept
@~ J, Bm
- 1, Bosch
- 1, Comau L
(- 4, Denso L
&~ 4, Dumr
[#- 1, Eisenmann
(- J, Fanuc
- 4, Gudel
- Lo lgm
(- |, Katana -
Name Groke Typ Letzte Anderung... 4
|_NJ-110-3,0.r0b 23KB ROB-D.. 26.01.201311:56 __
= NJ-130-2,6 jpg 7KB JPEG-Bid 31.10.2011 14:22 ‘E‘
|| NJ-130-2,6.r0b 23KB ROB-D.. 26.01.201311:56
|e=|RACER-7-140jpg 7KB JPEG-Bild 28.07.2014 09:45
88| RACER-7-140.r0b 21KB | ROB-D... |21.08.2014 15:31
= SM-NH3-165-3.0jpg 8KB JPEG-Bid 10.02.201001:32
|| SM-NH3-165-3,0.r0b 21KB ROB-D.. 26.01.201311:57
|| SM-NH3-220-2,7-Expl-SM... 2KB PRG-D.. 28.01.201310:46 Proj.-Manager
| SM-NH3-220-2,7-Expl.cel 27KB CEL-Datei 28.01.2013 10:46
[==] SM-NH3-220-2, 7-Expl jpg 12KB JPEG-Bid 28.01.201310:32
= SM-NH3-220-2.7 jpg 8KB JPEG-Bid 10.02.201001:23 Load
| | SM-NH3-220-2,7.rob 21KB ROB-D.. 26.01.201311:57 ~
© *cel /*rob Db @ c°cel @ allfiles (") @ search  “rob
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Device Manager

Paste a path of use Pre-Selection [History) and press ‘Goto'

IC.Proar.
CAmpREAST-ROB_Sandbowl serLioy
C v-ROI it

C\Programme\ EAST-ROB\ApplicalionLib\Paintingt

CAtmpAEASY ADE_Sandboripplicationl b\arcWeldig'
CAmpAEASY AOE_SandborTrairLibh
C\ProgrammehEAST-ROBATrainLibl

c il K

= v
C\Programme\EASY-ROB\T UtorialPral_evample_erpl
C\Programmes EAST-ROB\RobotlibhABE
C\tmphEASY-AOE_SanchoxtFobolLibAABEY
CoMmphEASY-AI0B_ S andhosAppli

Lib\Pairting'.

C\Programme! EAS-ROB\Applicalion b
viceLib

C\Programme’ EASY-ROB\T uterial\Pra_example_erpl
C\Programme\ EAST-ROB\Atomatical b
C\Programme!\ EASY-ROB\ALtomatical b\Painting

C Y
LC:ProgrammenEAST-ROB \Automatical ib\Handling

C:\Programme! EAST-ROB\pplicaiionLip\Cuiting
[ v-ROB\Fiobotlib\4ER

Proj.Manzger | [ Captureimage | [ Load ] [ Carcel ]

O el £ ioh O *rob @ el

Pfadhistorie:

Ladt der Benutzer eine Zelle oder einen Roboter in
EASY-ROB™, wird der Pfad aus dem die Datei
geladen wurde in die Pfadhistorie an erster Stelle
gespeichert.

Maximal werden 12 Pfade abgelegt, wobei gleiche
Pfadnamen nur einmal gelistet sind.

Die Datei ,er_LoadFromLibPb.ini“, in der die
Pfadhistorie gespeichert ist, wird automatisch
verwaltet und sollte nicht manuell editiert werden

Paste a path or use Pre-Selection [History) and press ‘Gote'

IC.\Proar.
CAmpREAST-ROB_Sandbowl serLioy
C il it

¥

C\Programme’\ EAST-ROB\ApplicationLib\Paintingt
CmptEASY-AOB_Sanchos Applicationl b\ArcWelding\
CMmptEAST-ROB Sanchos TranL b

C\Programme! EAST-ROB T rainLibl.
C v ROBAnel

LibAK;

Rl
CF v-ROB
Co\Programme’\ EASY-ROBT UtorialPral_evample_erplt
C\Programmes EAST-ROB\RobotlibhABE
C\tmphEASY-AOE_SanchoxtAobolLibAABEY
CoMmptEASY-AOE_Sanchortapplcationlib\Painting

C\Programme! EAST-ROB\Applicalion ib
C\Programme’ EAST-ROB\DeviceLib
C\Programme\EAST-ROB\RobolLb

Co\Programme’ EASY-ROBT utarialPra_example_erpl
C\Programme\ EAST-ROB\AUomatical b
C\Programme!\ EAST-ROB\ALomatical b\Painting

= v-ROB

C\Programme’ EAST-ROB\Atomatical b\Handing
C\Programme! EASY-ROB\A tomatical b\Devices
C\Programme’ EAST-ROB\ApplicationLi\WC
C:\Programme! EAST-ROB\pplicaiionLip\Cuiting

L C \Plnﬁvamme\EASY—RDE\HohnlL\h\AEB

Bevorzugte Pfade:

Im Unterschied zu der automatisch erzeugten
Pfadhistorie, bleiben die ,bevorzugten Pfade*
unverandert und ermdglichen dem Bediener so
einen schnellen Zugriff auf seine 12 wichtigsten
Pfade

Diese ,bevorzugten Pfade” sind vom Bediener
anzulegen und werden in der Datei
»er_LoadFromLibPb_prefered.ini“ im EASY-ROB™-
Hauptverzeichnis gespeichert und kénnen tber

Ot O O pasene | L] L J L] |1 Vo i/File/EI/EASY-ROB-SystemFiles editiert
werden.
© el / “rob ) *rob ) el Oafiesry | Auswahl des anzuzeigenden Dateityps
in der Dateiliste
) Mit der Eingabe eines Suchbegriffs im
(") search “rob Eingabefeld und einem Klick auf ,search® kann
nach Devices gesucht werden..
E Daten der Arbeitszelle an den Project
Proj.-Manager
Manager senden
et Funktion zum Erstellen eines

Screenshots

Load

Laden der gewahlten Datei

Cancel

Abbruch der Funktion
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E 3D Robot Simulation Tool

EA SY'ROB ™ Bedienungshinweise
Dialoge & Windows

Capture Image

Im EASY-ROB™ Capture Image Dialog kann der Bediener wahlweise Screenshots im BMP- oder JPEG
Format erzeugen.

1.
Laden Sie zunachst Uiber den Library Dialog den
Roboter oder die Arbeitszelle ins EASY-ROB™

2. T EASY-ROB Device Manager V5.601
Nach dem Laden der Zelle oder des Roboters o e o T 5 ]
wird im EASY-ROB™ Device Manager ,Capture or et e plh by s ek
Image“ aufgerufen. ® 2 Semeei
(&) Arcwelding
1) AutoPath
=
() Kinematics
Tipp: Markieren Sie zuerst die E:.p
gewiinschte Datei zon
(im Bild ,multi_paint_01.cel), b= o
. “ ) Robot-Calibration
bevor Sie ,Capture Image 2 3 Erag
aktIVIeren . a:\‘jln_ piaint_1 cel Da;:m;eng; Te 33
Nur so wird der Dateiname fuir ‘32:?!8?3.“‘ oot
das Blld Ubernommen [ yongkab.cel 29.04.2009 16:45
Load
O*cel /"o O%wb @ cel O alfiles (2]

3.
Positionieren Sie das Motiv im ,Capture Image
Fenster“ nach Belieben.

Mit ,,Shoot” wird vom gewahlten Ausschnitt eine
BMP- oder JPEG-Datei erzeugt.

Das Bild wird im selben Verzeichnis gespeichert,
in dem auch die Arbeitszelle gespeichert ist.

CAprog\EASY-ROBALIBS\A meuss_uer_Appicationl b\

Technische Anderungen und Verbesserungen sind vorbehalten 59/109

EASY-ROB Software GmbH Hauptstr.42 65719 Hofheim am Taunus Germany Tel. +49 6192 921 70-77 Fax. +49 6192 921 70-66 info.er@easy-rob.com www.easy-rob.com


mailto:info@easy-rob.com
http://www.easy-rob.com/

™ EASY-ROB

(]
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EASY'ROB ™ Bedienungshinweise
Dialoge & Windows

Navigator Window

Das Navigator Window wird verwendet, um in der 3D Szene Geometrien und Tagpunkte anzuwéahlen und um
Distanzen zu messen. Mit der Einstellung des Cruise Mode wird festgelegt, um welchen Punkt Cruise-
Drehpunkt im Raum die 3D Szene gedreht werden soll.

w

Auswabhl fir Messungen —————no selection |
[ Fick &Click | [ Camera | —v-—— Kameraeinstellungen
0
[l
LME “Ward Yigw
(@ Rot ) Pan ) Scale
Festlegung des Cruise- Cruise Mode

Drehpunktes in der 3D Szene &  [y0icomys |v| [-

Select Body/Tag
Auswahl fiir Messunaen Waéhlen Sie mit der linken Maustaste eine Geometrie oder
9 einen Tagpunkt an. Dieses Objekt ist aktuell (current).

Point Measure
Wahlen Sie mit der linken Maustaste einen Punkt an einer
Geometrie an, um die Punktkoordinaten anzuzeigen.

Distance Measure
Zur Abstandsmessung zwischen Punkten, Flachen und

Praint b easure
Distance Measure Tagpunkten.

Durch Auswahl von Modify World View mit @b wird

die 3D Szene verschoben, hinein- und

hinausgezoomt und um einen Punkt im Raum gedreht.
Cruise-Drehpunkt festlegen Als Drehpunkte stehen folgende Bezugssysteme zur Verfiigung.

» World Coorsys: (Grundeinstellung)
Cruise-Drehpunkt ist das Weltkoordinatensystem.

* Robot Base:
Cruise-Drehpunkt ist das Roboter Basissystem.

* Robot TCP:
Cruise-Drehpunkt ist der TCP des Roboters.

* current Body:
Cruise-Drehpunkt ist das Koordinatensystem der aktuellen
Geometrie oder des Tagpunktes.

* picket Point:
Cruise-Drehpunkt ist der ausgewahlte Punkt an der Geometrie.

Cruize Mode

Fiobot Base
Fobot TCP
curment Body
picked Point

Technische Anderungen und Verbesserungen sind vorbehalten 60/109

EASY-ROB Software GmbH Hauptstr.42 65719 Hofheim am Taunus Germany Tel. +49 6192 921 70-77 Fax. +49 6192 921 70-66 info.er@easy-rob.com www.easy-rob.com



mailto:info@easy-rob.com
http://www.easy-rob.com/

™ EASY-ROB

(]
N 3D Robot Simulation Tool

Navigator Window

Mit der Leertaste (Spacebar) kann zwischen dem aktuellen Mouse Mode und dem letzten Mouse Mode
hin- und hergewechselt werden.

Mouse Mode Toolbar =]

‘ @. TCF TCP TCF ROBOT  ROBOT @ SEL WORK @ AEBS TCP :

TooL BASE WORLD  JOINTS BASE DF TAG oB.J Pl CODRD Joa

Kamera-Einstellungen Mit der Kamera werden optimale Blickwinkel eingestellt. Sie ist
idealer Weise einer Geometrie zugewiesen. Ist der Mouse Mode
~Modify World View* aktiv, kann mit der TAB-Taste zwischen

Kamera- und Welt-View hin- und hergewechselt werden

Die Blickrichtung ist gemafd OpenGL™ Definition immer in die
negative Z-Richtung.

Ein / Ausschalten ¥ @

der Kamera | [JEnable Camera <— Dialog beenden
Focus Z affset <4— Kameraeinstellungen zuriicksetzen
Focus und Offset <— Kameraeinstellungen tibernehmen
Einstellung . .
Ic <4— Geometrie auswahlen
Attach to Fief_Tool REF_TOOL Grp_Rol
L0 Jnlde 0
Focusz length 51,230 mm
P Z offzet 0,000
El.genSChaﬂen Position 0.0 00 0.0 [mm]
-Liste O > 0.0° 180.0° -30.0°
FatuE Der Fokus wird pro Klick um 10 mm verandert.
Um einen genauen Fokus-Wert einzustellen - Doppelklick auf
9 PP

Focus length in der Eigenschaften-Liste.

> cifsst Der Z Offsetwert verschiebt die Linse in z-Richtung (Blickrichtung)
Mit jedem Kilick &ndert sich der Z offset um 10mm.

Um einen genauen Offsetwert einzustellen - Doppelklick auf

Z offset in der Eigenschaften-Liste.

Mit einem Doppelklick auf einen Wert in der Eigenschaften-Liste
kénnen genaue Zahlenwerte eingegeben werden.

Eigenschaften-Liste :

Attach Camera to

Auswahl an welcher Geometrie

i 1 - Robot Tep
Attach to Fief_Tool REF_TOOL &re—fe—» oder welchen Punkt die Kamera 2-Robot Tep Ry = 120
+0 dnt_ldk D "attached" werden soll 3 Hobo G =180 Rz =3
Focus length 51.230 mm a : g ?SElotG?;ﬂuD
£ offset 0.000) rrm Wm
Puozition 0.0 0.0 0.0 [mm]

ari, --» 0.0 180.0° -30.0° Current selected ltem
E-Body Group

~a Offsetverschiebung und -drehung
bezogen auf das Bezugssystem der Kamera.
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EASY'ROB ™ Bedienungshinweise
Dialoge & Windows

Frame Dialog

Der Frame Dialog dient zur Eingabe von kartesischen Koordinaten. Um beispielsweise 3D Geometrien, die
Roboterbasis oder den TCP’s des Roboter neu festzulegen, werden im Frame Dialog die aktuellen X-, Y- und
Z-Werte mit Orientierung angezeigt und kdnnen geandert werden. Die neuen Koordinaten werden sofort
visualisiert, ohne den Dialog zu schliel3en, womit sich die Eingaben schnell Gberprifen lassen. Weiterhin
kdnnen aktuelle Positionen gespeichert werden, um sie anderweitig zu verwenden. Auch das Multiplizieren
und Invertieren von homogenen Matrizen (Frames) ist moglich.

Der Frame Dialog z&hlt zu den zentralen Benutzerdialogen in EASY-ROB™ und wird bei der Bedienung am
haufigsten benutzt.

T Frame Dialog

Modify cTag Poge T_1 [mm/deg]

E

w | 450000 |py| 0.0000
v | a00000 |gy| 1800000 | [GiUpdate
z | 700000 gz 0.0000
Diist, 834,530
EASY-ROB FifigRz |
dist| 100000 |gr| 30.000
Frame T2 |:| absol.
Frame |
1% 0.0000 =
2-v. 0.0000
3.7 00000 -
4-Fiw 0.0000 i
5-Fy 0.0000

+|[=][+
RS

nx1.000000 +

L3
] =

LCancel

Schlie3t den Frame Dialog und Ubernimmt die eingegebenen Koordinaten.

Help Kurzinfo zum Frame Dialog.

Aktualisierung der 3D Szene entsprechend der eingegebenen Koordinaten.
Grfllpdate “GrafikUpdate” bietet so sich zu einer schnellen Uberprifung der
Koordinaten an, ohne den Frame Dialog zu verlassen.

Rucksetzen auf die Ausgangskoordinaten als der Frame Dialog geotffnet

| =
=

Rezet
wurde.
Copy Kopiert die Koordinaten in die Frame-Liste (Zwischenablage).
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Frame Dialog

Pazte

Kopiert die Koordinaten aus der Zwischenablage.

Set [dent

Setzt die Koordinaten und Orientierung auf null, bzw. Einheitsmatrix.

LCancel

SchlieRt den Frame Dialog ohne die Anderungen zu ibernehmen.

Modify T ag Poze T_1 [mm/deq]

Die Informationszeile zeigt die Zugehdrigkeit der Koordinaten an.

Koordinaten-Eingabefelder fur Position und Orientierung.

s | 450000 Ry 0.0000
Auch Formeln sind erlaubt, z.B. ,200.0+57.3*pi/180%, ,0.2* m2mm*
200.000 180.0000 . ; ” r ’
v iy ,100*sin(45*RAD)", ,a1=5:8*a1“ oder ,3*a1"
Wechseln sie mit dem Cursor in ein anderes Edit-Feld um die Berechnung
Z | 700.000 jRz) 0.0000 ausfuihren zu lassen.
Dist. 864.530 Dist. errechnet die Betrag aus dem x-, y- und z-Wert aus.
distl 100000 |gp| 90.000 Die Schrittweitenvorgabe gibt einen ,Deltawert” vor, um den ein

Koordinatenwert inkrementiert oder dekrementiert werden soll.

Die Positionskoordinate X, y, oder z wird mit einem Klick auf die folgenden
Schaltflachen

- -dx oder +dx in x Richtung
- -dy oder +dy iny Richtung
- -dz oder +dz in z Richtung

um die Schrittweitenvorgabe ,dist verandert. Die Anderung erfolgt absolut
oder relativ. Die 3D Szene wird zur Kontrolle sofort aktualisiert.

Die Orientierungskoordinate Rx, Ry, oder Rz wird mit einem Klick auf die
folgenden Schaltflachen

- -Rx oder +Rx um x Richtung
- -Ry oder +Ry umy Richtung
- -Rz oder +Rz um z Richtung

um die Schrittweitenvorgabe ,dR“ verandert. Die Anderung erfolgt absolut
oder relativ. Die 3D Szene wird zur Kontrolle sofort aktualisiert.

Die Anderung erfolgt absolut im Bezugssystems Tneu = dT(dist,dR) * Tait

Die Anderung erfolgt relativ Theu = Tart * dT(dist,dR)

Technische Anderungen und Verbesserungen sind vorbehalten
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Frame Dialog

EASY-ROB RsfyRz | v

|E&SY-ROB RxRyRz |

EASY-ROB RxRyRz
E4SY-ROB RPY Roll Pitch vaw
EUKA KRC1 RzRyAx

Vorgabe der Orientierungskonvention und
Umrechnung der aktuellen Orientierung
in andere Handgelenksdefinitionen.

: Feis RzRvRx
z.B. + ABB S4 Quaternionen
- KUKA KRC1 RzRyRx o

* Staubli RzZRyRz
* Fanuc Karel RJ Roll Pitch Yaw
* Tricept TR8x5 Rz(C)Rx(A)

Staubli RzRvRz

ABB 54 Quaternions

Tricept TRBxE Rz[CIR=[A]
Fanuc F.arel AJ Roll Pitch v aw
b+m T1 Bux RzRypRz

b+ T1 7w RvaR=Rz

w0 450,000 |Rw| 0.0000
v 300000 Ry | 180.0000

Z| 700000 Re| 0.0000

Digt. 984.590

dist| 100,000 | 4R §90.000

Frame T2

EASYROB Refvie v

Frame-Liste fir Matrizenberechnung.

Koordinaten werden verrechnet, indem die aktuellen Koordinaten
(bezeichnet als Matrix T1) zuerst in die Zwischenablage (dort als Matrix T2
bezeichnet) kopiert werden.

Die homogene Matrix T2 lasst sich nun invertieren oder mit einer aktuellen
Koordinate T1 verrechnen.

Das Ergebnis in T2 kann aus der Zwischenablage nach T1 zuriickkopiert
und dort weiterverarbeitet werden.

Clipboard Frame A
2 - 300.0000 Besonderheit. . o
3.7 700.0007 Ein Doppelklick in der Frame-Liste auf z.B. ,1 - X: 1000.000“ bewirkt, dass
4-Rx 00000 der Wert in die X-Koordinate bernommen wird. Gleiches gilt fur die Y- und
5 - Ay: 180.0000 Z-Koordinate und fiir die Orientierungskoordinaten.
E- Rz 0.0000

Vertauscht Matrix T1 mit Matrix T2.

Undao Setzt nach erfolgter Berechnung die Matrix T2 auf den urspriinglichen Wert
zurlck.

T2=T1 Matrizenmultiplikation T2=T2*T:

T1=T2 Matrizenmultiplikation To=T1*T2

iT2=T1 Matrizenmultiplikation Te=T21*Ty

iT1=T12 Matrizenmultiplikation To=Til*T2

imverse [ T2 | Matrizeninversion To=T21
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EA SY'ROB ™ Bedienungshinweise
Dialoge & Windows

3D CAD Window

Das 3D-CAD Window dient zum Importieren und Positionieren von 3D Geometrien, sowie der Zuweisung
von Farben und weiteren Attributen.

Durch einen einfachen Mausklick auf den Button fﬂiﬁll ird das 3D-CAD Window aufgerufen.

T 3D-CAD Window =)

File 3D-CAD  View

M anipulate Pogitions ﬁgg

A WE.4
Offzet Pozition VEE
wfiorld Pos

l Clear cBaody ] [ Up H Diawn ]
’ terge Bodies ] [Snap ko F'u:u” b ouzetd ]
| [T] Measue [ Refresh ” Fick. ]
I ame #0
Aftach to actJnt. 0 =
Scale 1.00007.0000 1.0000 Size 0501
[Grab statuz Mo =
CaD type IGP [62 Pol/Obj OK] 0 Clones
ColorRGE 255 285 285 15 Alpha1.0di
Render Smiooth
Irvwvert Mo
BF acelCulling ez
Show Mame Ma
Show Mormals Mo
Show Mesh Mo i

In der Bodyliste werden alle Namen der Geometrien zur aktuellen
Gruppe angezeigt.

Bodyliste
Ein zweifacher Mausklick auf ein Listenelement gibt detaillierte
Information zur Geometrie.
Technische Anderungen und Verbesserungen sind vorbehalten 66/109
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3D CAD Window

In EASY-ROB™ stehen drei Gruppen fir die Erstellung von
Bodies zur Verfigung. Sie kdnnen unabhéngig voneinander
bearbeitet und gespeichert werden.

Robot Group 7 Selection Dinlog. X
S lect Body Group
Auswahl der Gruppe -
File > Save - Robotfile 3 Body G v [=ez]
Toolfile e
Bodyfile
Lreate Impart Bodies kdnnen neu erstellt oder importiert werden.
) Imoor I?_@
Body Erstellen / Importieren Po tausTM
EASY' RO B Select a type to import for “Fobot Group"
3D-CAD Library
.[ from Library [ad
o 3- PYREMID
A 4 -'WEDGE
Primitive Korper { % LNDER
G- CONE
erstellen S e
8-1GP PART FILE_
Import vorhandenen ™| ;5 =" o frer e -
3D-CAD Dateien. Current selected ltem
VRML | + 11 (97) Daten 1 - 30 CAD fram Library

miissen vorab als IGP®
Partfile gespeichert

Die Eigenschaft der aktuellen Geometrie kann durch Doppelklick
geéandert werden.

Eigenschaften der Geometrien

Hame #O B0 Ly

Aftach to actdnt. 0 — #[Nummer] Name

éca';e 1£DDD 1.0000 1.0000 \\‘ [angebunden an Achse] (0 = Roboterbasis, 1-12 = aktive Achse 1, sonst
rab statuis 1 . = passive Achse)

Body ype IGF Part_[62 Pol/Obi OK] e Skalierungswert der Geometrie

Color R G B 250 256 255 15 - 9

Render Smooth ~SA

[reeert Mo Typ und Zustand

BFaceCulling Yes \

Show Mame Mo

Show Mormals Mo RGB Farbwert

Check Collision  Cohcave L» Offsetposition und -orientierun

Offzet Pos. 0o oo D.D[mm]/ P 9
O, - 0o o000

HEDF'“_ l_:j;?s' D_D”;%_S;”D_S;” ] ——p Produkt aus Referenzposition und Offsetposition

Refer. Pos. 0.0 0.0 0.0 [mm] ~1L |

Ori. 0.0° 0.0° 0.0 > " I
world Pos. 1600.0 -700.0 0.0 [mrn] Referenzposition und Referenzorientierung

Ori. --» 0.0° 0.0° 1200

|

—» Worldposition und -orientierung

Anderungen speichern / zuriicksetzen L . .
9 P Wurde der aktuellen Geometrie eine neue Position zugewiesen,

kann diese mit Save als Startposition gespeichert oder
[ Reset ” aave ] mit Reset verworfen werden.
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3D CAD Window

[ Clear cBody ]

aktuelle Geometrie aus der 3D Szene l6schen

[ terge cBody ]

mergen des gewahlten Kérpers ( siehe dazu auch ,Import von

VRML" in diesem Dokument)

Verschieben des Bauteils in der Liste

Position / Orientierung
der Geometrie

Die Position und Orientierung der aktuellen Geometrie kann im

Frame Dialog verandert werden.

T —-]
Position DES00_4 [mm/deg] 0K
. . Dreht und
b anipulate Positions verschiebt den x 000 |me 00000
= Body um das v| 0000 |py| -90.0000
[ Offzet Pozition ] y ! — m—
Weltkoordinaten- z| 000 Rz O
|Ref-Pos | [Ref *0ff | System. e 00
ESYROB FefyRiz | v )
wforld Paos ol 1m0 || S0000 Dreht und verschlebt
S — den Body um sein
[ Reset ” Save ] Frame =] (2 2 €igenes
Y oo Koordinatensystem.
35 Do
2 A S B Nach jeder Drehung
R
e e Rkt
eine andere
Ausrichtung.
| Difset Position | Offset-Position Toit
Fef-Pos Referenz-Position Tret

Produkt aus Referenz-Position und Offset-Position  Tref * Toft

World P

Vom Weltkoordinatennullpunkt ausgehend.

Check Box ,Measure* zum Offnen
des Navigator Windows

Tipp:

Im Navigator Window gemessene Werte
werden kdnnen weiterverwendet werden, in
dem beispielsweise fur den Wert 877.337
die Systemvariable $dx verwendet wird.
Mihseliges abtippen oder gar merken
entfallt.

| Eoviotor Window = = X

Distance Measure v

[vertices  [__unselect_]
[T hold 15t Paint
$Dist 384.245 [rom]
$dx 233 494 [rm]
$dy 175.000 [rmm]
$dz 250.000 [rmm]
$iP 450,000 300,000 550.000 [
$iN -0.000 0.000 -1.000
$oN -0.000 0.000 -1.000
LMB word Vi

@ Rot O Pan () Scale

Cnisz Mode:
Robot ToP v | O]

Technische Anderungen und Verbesserungen sind vorbehalten
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3D CAD Window

Koordinatensysteme

Referenz
Position Offset Position
Produkt aus Geometrie
Referenz- und
Offset Position
z.B. Roboter
Achse
World Position
Weltkoordinatensystem (0,0,0)
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EASY-ROB™

Kinematics Window

Dialoge & Windows

Bedienungshinweise

Tastenkombination ,,Ctrl+K"“

1 Kinematics Window

File Reobotics View Transformation

#1/1 AWE 35316858

(<|[selfigbeti [»] [ PickFRobot | [ Load |
[ Re Attach ] [ Shap o Paoly ] [ Save ]
[culentﬂobot Attributes '] [ UnLoad ]
Y arne Adtribt
Robat Type FRobat
Fiobot Enabled Enabled . .
Robot Render Wigible
Tool Render Wizible
Fobat Callision es
Tool Collision es
Feference Collision Mo Start
Ihwerse Kin. 1D available & alnt: Condition
Attached to Ref_‘world
Mot Synchronized
Baze Pos. 0.0 00 0.0 [mm]
1 Ori. > 0.0 0.0 0.0
| Tool TOOL_T 0.0 0.0 0.0 [mr
Ori. > 0.0° 0.0 0.0
|| | Tep Pos 8100 0.0 1035.C
Ori, > 0.0°180.0° 0.0°
Tep Track Ref Baze Jnt_ld

Das Kinematics Window dient dazu, einen einzelnen oder mehrere Roboter in der Arbeitszelle zu handhaben
bzw. die Eigenschaften zu manipulieren.

Aktiviert wird das Kinematics Window entweder tiber das Menl Robotics / Open Kinematics Window oder die

M arne ROBOT #1

Robot Enabled Enabled

Robat Render Wizible

Tool Render YWizible

Robat Colizion  Yes

Tool Collizion Tes

Reference Collizion Mo

Iwerze Kin, 1D available B alnt:

Attached to Ref_world

Baze Pos, 0.0 0.0 0.0 [mm]
Ori. - nosoo oo

Tool data 0.0 0.0 2000 [ror
Ori. - nosoo oo

Tcp Poz, 531.3 1948 731
Ori. - 1788°6.0° 715"

Tep Track Fef Baze Jnt_ld

Die Liste enthalt Informationen zum Zustand des gewahlten Roboters wie:

- Name
- Attach to — Status

- Position / Orientierung der Basis, des TCP’s und des Tools

Hinweis:

Mittels Doppelklick auf die Eintrage kdnnen Werte geéndert werden.

Technische Anderungen und Verbesserungen sind vorbehalten
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Kinematics Window

Auswahlen eines Roboters
Mit bzw. wird zwischen zwei Robotern hin- und hergeschaltet

wird der folgende Dialog mit einer Liste aller in der
Arbeitszelle befindlichen Roboter geéffnet:

Select Robot
1-#1-ROBOT is current L |
2-#1 -ROBOT
3- H2 - AR

Current zelected [tem
1-#1-ROBAT iz curent

Re-Attachen eines Roboters

Offnet den folgenden Dialog:

Re attach cRobot 'ROBOT' ta

Base

- Fobat Tip
-Robot Tep
- Robat Jaint
- Grab to

- Fick Body
- quit

[enli e i B TR Y L

Curent zelected [tem
1 -World

um den aktuellen Roboter an einen anderen ,Link" zu attachen.

Pick Robot

Auswahlen eines Roboters

Nach Aktivierung des Buttons kann ein Roboter direkt in der Arbeitswelt durch
Auswahl mit der Maus aktiviert werden

Load

Laden eines weiteren Roboters

Save

Speichern des aktuell ausgewéhlten Roboters

LIl

Snap to Paly

Shap to Wertex

Roboter springt (Snap) an ausgewahltes Polygon oder Vertex
Bei ,Snap to poly” wird die Normale beriicksichtigt.

Technische Anderungen und Verbesserungen sind vorbehalten 71/109
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Kinematics Window

~Entladen® / Entfernen eines Roboters aus der Arbeitswelt

Attribute des Roboters

Nach Auswahl des Buttons 6ffnet sich der folgende Dialog um die dort
genannten Eigenschaften zu verandern.

1 Selection Dialog

'H2 - IRB-5400-2-15" Attributes Ok,
- Mame ‘|RE-5400-2-15" Cancel
-ToolData 'TOOL_T'

dak

- Home Pozition 'HOME_1* ta do 7
- 5% Travel Ranges

- 5% Travel Ranges Dependencies
- Joint Sigre

- Joint Offzets

- Jaint Singul. Tal.

-Jaint Speeds

- Joint Accels

-Jaint Tarques

- TCP Speeds, Accels

- Configurations

- Extended Attributesz

- Tum Interval

- Aattributes Information

- Guit
Current zelected [hem
1 -Mame '|RE-5400-2-15'

[on R B Rm p By B S PR O RC

R
—_ =

R S R S N
e e A B o TR LN

Kinematik des Roboters

Nach Auswahl des Buttons 6ffnet sich der folgende Dialog:

1 Nz 00000.0000<=| 500.0000 | <=100000.0000 [~

2 Ny 000000000 <-| 0000000 | <- 1000000000 |
3y 00000.0000 <= 0.000000 | <=100000.0000 0.000000
4 22 0.000000 ¢=  500.0000 | <=100000.0000
5 2 00000.0000 <=|  0.000000 | <=100000.0000
B 12y 000000000<= 0000000 | <=1000000000 [y

Hier kbnnen kinematische Langen und Drehrichtungen veréandert werden.

Erzeugen eines weiteren Roboters
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Kinematics Window

Startbedingung speichern oder zurlicksetzen

% Selection Dialog

Save cRobot '|REB-5400-2-15" ag Start Condition

Bl

Start
Condition 1 - Save cRobat Joint Pozition Cancel
2 - Save cRobot Reference —
3-5ave cRobot Baze toda?
Reset 4 - Save cRobot Toal L
5 - Save cRobat Render
‘b - Save cRobot Jomts + FHeference + Base + Tool + Render
¥ - Save all Robots Joints + Reference + Base + Tool + Render
8 - Quit

Curent selected lem

£ - Sawe cRobat Joints + Reference + Baze + Tool + Render

-Refresh® Aktualisierung der Daten in der Zustands-Liste

Technische Anderungen und Verbesserungen sind vorbehalten 73/109
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EASY'ROB ™ Bedienungshinweise
Dialoge & Windows

Jog Window

Das JogWindow dient dazu, den Roboter mit einer 3 Tastenmaus schnell und tbersichtlich in den einzelnen
Achsen oder im TCP bzgl. Werkzeug- oder Weltkoordinaten zu joggen bzw. zu manipulieren. Zuséatzlich
konnen die Verfahrbereichs- und Kollisionsiiberwachung aktiviert werden.

T JogWindow 1 sl =i

@ 13 @ 13

D 46 © 1
79 ® 2

(1012 @ Rotate 0 3

[ Pick Bobat ][ Cruize ]

Daouble Chek a Crd to Bun fram List

I Some example CP-ations LIM
LIMN_Rel0O0 0150
LIM_RelOO0 04150
LIM_RelOO0 1500

LIkl D~ N AR0 N

=
5 | enter a command

Die Liste enthélt einige ERPL- und ERCL Beispielbefehle,

[A

I Some example CP-Motions LIM
LIN_Rel 000 0 150 wie Bewegungsbefehle LIN, LIN_REL, CIRC ... usw.

e e ERCL - Befehle Color, Track, Tag ... usw.

v Weitere Befehle kénnen der Liste hinzugefiigt werden.

Durch Eingabe, oder Doppelklick auf einen Befehl in der Liste, wird der Befehl
in die Commandzeile ibernommen.

Mit +| wird der Befehl an die aktuell markierte Stelle eingefiigt.
E‘} | enter a command | getig

Mit -] wird der aktuell markierte Befehl aus der Liste geldscht.

Mit Hun| wird der Befehl in der Commandzeile ausgefihrt.

Die Achsen 1 bis 3 werden mit einer 3 Tastenmaus bewegt, indem die

Jrb 1t 3 . . L .
® i3 Maustaste gedriickt und die Maus gleichzeitig in der 3D Szene bewegt wird.
O 45 Linke Maus-Taste Achse 1
O 79 Mittlere Maus-Taste Achse 2
Rechte Maus-Taste Achse 3
O 1012 . . y
Mit der TAB-Taste werden die Achsen 4-6, 7-9 und 10-12 angewahit.
Technische Anderungen und Verbesserungen sind vorbehalten 74/109
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Jog Window
LME Jnt. Belegen der Achsen auf LMB
® 13
O 1
O 2
O 3

Joggen der Achsen

TCP-Bewegung bzgl. Werkzeugkoordinaten - TCP Tool Mouse-Mode.

TCP

Diese Funktion entspricht dem Short-Key T

TCP-Bewegung bzgl. Weltkoordinaten > TCP World Mouse-Mode.

Diese Funktion entspricht dem Short-Key wﬁ:n
{(*) Fiotate Umschalten der TCP-Bewegung auf rotatorisch
[ Pick Fobot ] Auswahl des Roboters
Einschalten Cruise Mode
Technische Anderungen und Verbesserungen sind vorbehalten 75/109
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EASY'ROB ™ Bedienungshinweise
Dialoge & Windows

Tag Window

Im Tag Window werden Pfade unabhangig voneinander generiert, bearbeitet und im Raum platziert. Ein Pfad
besteht aus mehreren Tagpunkten und kann an eine Geometrie, an eine Roboterbasis oder —flansch
angebunden ,attached* sein. Andern sich Geometrie- oder Roboterposition, bewegen sich die angebundenen
Pfade automatisch mit. Ausgewahlt und bearbeitet werden kdnnen Tags einzeln oder als Gruppe. Die
Tastenkombinationen ,Str + A%, ,Str + C*, und ,Str + V* kbnnen wie gewohnt verwendet werden.

SEL

Das Tag Window wird mit einem einfachen Mausklick auf den Button ,SEL TAG“ aufgerufen. TG
™ Tag Window
File Move Attributes Manipulate View
#141 PATHO1:WOBJO1 Tag
cPath clTag -
-
(<|[selPth][>] [New TCP Tag)
[ Re Attach ] [cTag to TCP]
| Path | wobi| |Prefix| [ Name|
[Clone][ NewJ [Clone}
[Delete cPathJ [ Delete cTag ] -
I wobipose
X o000 R 00w
Move -> cTag
Y oo P oow
2 oo v oow
Motion type
[ Save J [ Reset ] 9 Default
Name #- WOBJ( . @ PTP
Path Owner - Disabh LN
Attach to Jnt. Ref_Worl =
“Wobj. Pos. 00001
Ori. > 0.0°0.0°0.0 Mousetode Tag
Pick] [Paly
~| @
[(1TCPJog  [|ShowcTag [ Measure
(] Show Text [¥] Connect [ Show Path
no Tags
A
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Tag Window

TCP Jog Der Roboter springt zum markierten Tagpunkt.
Es werden die Tagpunkte des ausgewdahlten Pfades mit farblich
gekennzeichneten ,Pfeilen miteinander verbunden.

Show cTag * violett: vom Referenzsystem zum Wobj-Frame
* griin: vom Wobj-Frame zum 1. Tag
* gelb: vom 1. Tag zum folgenden (2.) Tag usw.
* rot; vom vorletzten Tag zum letzten Tag

Measure Offnet den Navigator Dialog

. In dieser Liste werden alle Tags des aktuellen Pfades angezeigt.
Tagliste

Mit zweifachem Mausklick auf einen Tag, wird er angefahren.

Tagpunkt an

Geometrie erzeugen.

Es kénnen Tagpunkte an Geometrien erzeugt werden.

Position auf der Geometrie auswahlen
neuen Tagpunkt am TCP erzeugen
ausgewahlten Tagpunkt platzieren

Maustaste links:
Maustaste mitte:
Maustaste rechts:

Die Position an der Geometrie wird mittels rosa Pfeils angezeigt.

Verschiebt in der Tagliste den markierten Tagpunkt, um eine
Position nach oben bzw. nach unten.

b owve Along

Vom ausgewahlten Tag bis zum letzten Tag des Pfades fahrt der
Roboter die Tagpunkte nacheinander an. Die Bewegungsart wird
mit dem Tagpunkt vorgegeben.

Ausgewahlten Tag anfahren, > Doppelklick auf Tag in der
Tagliste

Auswahlen des néchsten oder vorigen Tags aus der Tagliste.

Mation type Bewegungsart
() Motype des Roboters
QPP
O LIN

Mit dem Button verfahrt der Roboter zum

markierten Tag. Die Bewegungsart kann wie folgt vorgegeben
werden.

Motype Attribute wie in Eigenschaften des Tag beschrieben ist
PTP Bewegungsart PTP (Point to Point, synchro PTP)
LIN Bewegungart LIN (linear)

Tagpunkt-Eigenschaften

Mame #1 wW0OB2 KREIS:T_1

Attach to

“Wiohj. Pos.
Qi - .o 00 oo

4500 300.0

Oi-»> 0.0 180.0° 0.0°
Extdwiz Abtnib. 0

000 [ram]

Durch Doppelklick auf eine Tagpunkt-Eigenschaft kann diese in
einem neuen Dialog verandert werden.
#[Tagnummer] [Worldobjektname] [Pfad] : [Prefix] _ [Tagname]

v
Ref Warld REF WORLD—6— An welchen Body der Pfad angebunden attached ist
0.0 0.0 0.0[mm] —— |, Position des Workobject-Frames

Orientierung des Workobject-Frames
Position des Tag bzgl. Workobject-Frame

Values \’Orientierung des Tag bzgl. Workobject-Frame

b otppe Dt —

Speed [41] 0° Omm 0° Bewegungsart des Tags

Zone -1.00 T Geschwindigkeit in Tagpunkt. ,0“ = nicht definiert

brocel [A572) 0° Omwm O°

Colr RGE 255 0 0 LIGHTRED — Farbe des Tags

Render M2 ——— | Darstellung des Tags

Length 50 rrirn . .

— ———» GroRe des dargestellten Tag-Dreibeins
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Tag Window

#2/2 PATHOZWOEBJOZ

# [Pfadnummer/Pfadanzahl] [Pfadname] : [Workobjectname]

cFath cTag
[ zel Pth ] [New TCP Tag]
[ Fie &ttach ] [n::Tag (] TEF']
| Path |[wiobi| | Prefis|[Name|
[Elnne][ New] [I:I-:une]
[ Delete u:F'ath] [ Delete cTag ]

i poss

cPath
Erstellen, Bearbeiten, Loschen und Auswéhlen von Pfaden.
-ReAttach” > Pfad an Geometrie oder Roboter anbinden.

cTag
Erstellen und Bearbeiten markierter Tags

b 0000  Fs 0.000
i 0000 Ry 0.000
z ool Rz 0.000

Save ][ Reset ]

Position und die Orientierung des markierten Tags oder des
Workobject-Frames kénnen eingegeben und verandert werden.
Entspricht einem Doppelklick in der Tagpunkt-Eigenschaftenliste
»1ag Position*

Pfad auswahlen

Pfad an eine Geometrie

oder Roboter anbinden MsclectionDiaog__________X|

Attach cPath 'KREIS' to
Wird die Geometrie bewegt, é?%ﬂgﬁzgggg;zgw
H - cRobot ip —
bewegt sich der Pfad gianontie [tocer]
automatisch mit. T

Current selected Item
5 - Pick Body

Name des Pfades und des Workobject-Frames andern

[I:Il:une] [New] [Delete n::F'ath]

Pfad klonen, erstellen und I6schen
Die Anzahl der zu klonenden Tags und der Abstand zum
nachsten Tag wird vorgegeben.

Mew TCF Tag

Neuer Tag wird an die aktuelle TCP Position des Roboters
erstellt, entspricht mittlere Maustaste im ,Pick a Tag* Modus

Der aktuelle Tag ,cTag® wird an den TCP des cRobot verschoben

Andern des Tagnamen [Prefix] _ [Tagname]

Klonen Léschen des cTags

| Clane| | Delete cTag

[Jiwob pose | Tag Position
Yw'obj Position

Offnet den Frame-Dialog zur Eingabe der
Tag- oder Workobject-Position
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Tag Window

5EL
TRG

MouzeMode Tag Aktiviert den MouseMode ,sel Tag*

Es erscheint =Tagals Cursor

nF

e

rick  Auswahl ,pick® eines Tags in der 3D Szene - cTag

Auswahl ,pick® eines Polygons oder eines Punktes mit dem LMB

Hinweis:

Durch driicken des MMB wird ein neuer cTag erzeugt.
Durch driicken des RMB springt der cTag an diese
~pick“-Paosition.

&> cTag springt (snap) an ausgewahltes Polygon oder Vertex

to Vertex Bei ,Snap to Poly“ wird die Normale berlicksichtigt

Aktualisiert die Daten des Tag Windows
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Tag Window

Erzeugen und Ausrichten von Tags

Vorgehensweise beim Erstellen eines Pfades und Anbinden an eine Geometrie

Geometrie erstellen

3D-CAD Window

o
b

Pfad auswéhlen

ggf. Name des Pfades und Workobject-Frames andern.

Tag on TCP erstellen

Mew TCF Tag

Der erste Tag wird an die aktuelle TCP-Position des Roboters
platziert.

Re Attach

Auswahl 5 — Pick Body

Geometrie anklicken, sie wird mit einer Bounding-Box umrahmt.
Alle nachfolgend erstellten Tags des Pfades sind an die
Geometrie angebunden und bewegen sich mit der Geometrie mit.
Die Geometrie kann auch zum Roboter/Maschine, Werkzeug oder
zum Werkstiick gehoren.

Pick a Tag

Weitere Tagpunkte kdnnen nun per Mausklick an der Geometrie
erzeugt werden.

Maustaste links LMB: Position auf Geometrie auswéhlen
Maustaste mitte MMB:  neuen Tagpunkt am TCP erzeugen
Maustaste rechts RMB: ausgewahlten Tagpunkt platzieren

Mit der rechten Maustaste (RMB) wird der aktuell ausgewéhlte
Tagpunkt an die Position platziert, die zuletzt mit der linken
Maustaste (LMB) (Pick & Click) ausgewahlt wurde. Die mittlere
Maustaste (MMB) wird lediglich dazu benétigt um dem Pfad einen
weiteren Tagpunkt hinzuzufligen.

Ist der Mittelpunkt eines Polygons selektiert worden, wird dessen
Normalenvektor als Approach-Komponente (i. d. Regel die Z-
Richtung) des Tagpunktes Gibernommen.

Zur Berechnung der X- und Y-Komponente des Tagpunktes wird
der VorgangerTag oder die aktuelle TCP-Stellung des Roboters
verwendet.

Ist ein Punkt an der Geometrie selektiert worden, wird als
Orientierung des Tagpunktes die aktuelle TCP-Orientierung des
Roboters verwendet.

Tipp: Richten Sie den ersten Tag am Polygon aus oder fahren ihn
mit dem Roboter an und richten diesen entsprechend aus.
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Tag Window

Koordinaten- und Bezugssysteme eines Pfades

Referenzposition » Weltkoordinatennullpunkt
* Roboterbasis
* Roboter Tip (Flansch)
* Roboter TCP
» Body/Geometrie
Ref. Pos.
Die Referenzposition des Pfades ist immer in Weltkoordinaten beschrieben und
hangt davon ab, an welches Objekt der Pfad angebunden ist. Die Werte der
Referenzposition &ndern sich wenn sich beispielsweise die Geometrie oder
Roboterbasis bewegen.
Workobject-Position ,Wobj.Pos.”
Die Workobject-Position ist bzgl. Referenzposition beschrieben.
Wobj. Pos. o o ] ) o
Bei aktiven Show cTag wird die Verbindung zwischen Referenzposition und
Wobj.Pos. violett dargestellt.
Tag Positions
Alle Tag-Positionen eines Pfades sind bzgl. Workobject-Position ausgedrickt.
Tag Pos.
Bei aktiven Show cTag werden die Tagpunkte mit gelben Pfeillinien verbunden,
wobei der Pfeil zum ersten Tag griin und zum letzten Tag rot gekennzeichnet ist.

PATH
Tag Point
IIT_3II

Tag Point

Wobj. Pos.

Tag Point
T o1

Ref. Pos.

Weltkoordinatensystem (0,0,0)
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EASY-ROB™
Dialoge & Windows

Teach Window

Bedienungshinweise

Mit dem Teach Window kénnen Simulationsprogramme in ERPL der EASY-ROB™ Program Language
und ERCL der EASY-ROB™ Command Language schnell und fehlerfrei erstellt werden. Die gewiinschten
Verfahr- und Simulationsbefehle werden automatisch zeilenweise eingeftigt und kénnen zum Testen
schrittweise ausgefihrt werden. Nach dem Abspeichern der erstellten Programmdatei kann das vollsténdige

Programm simuliert werden.

Simulation

1 Teach Window PRG_PTP.PRG (SR

ERPL-ERCL Settings 7

[ Reload ][ Editar ][ MHew ][Save as][ Save ][ Load ][Unload]

[#20

][ Inzert ][ Del ][ UnDeI][ Copy ][ FPazte ] [ Mudif_l,l]

Find |[>] "1 ROEOT_TOOL' > PRG_PTP.PRG'

v] Edit Prg

Program PRG_PTP.PRG Ioaded to ROBOT_TOOL'

FTP

_U
NHE
&

0
ok

|
o

> RUM
PrgStep

Help
Frgtain

R P
m|[o|(=
= =1 =
wllEN =S
A A

| cRobot ROBOT _TOOL'

| Below gection iz called once at t=0
I &dd Initialization commands here

|

Endinit
|
| Below gection iz called at t>0

I &dd new ERPL / ERCL commands here
|

SPEED_PTF_OW 30.0000
SPEED_CP_Ov  20.0000
SPEED_ORI_OV 80.0000
ACCEL_PTP_OYV 100.0000
ACCEL_CP_0v 100.0000
ACCEL_ORI_0% 100.0000

0v_PRO 100.0000
ERC NO_DECEL OFF
ZOME 0.0000

call MyMaveFct)
!

EndProgramFile
Ft Myb oveFct)

Hame HOME_1
PTPT 1

»

m
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Teach Window

Bearbeitung der aktuellen Programmdatei

Erneutes laden der aktuellen Programmdatei. Befehle im Programmfenster
werden Uberschrieben.

Ladt die aktuelle Programmdatei in einen Editor, entsprechend der Festlegung in
der Konfigurationsdatei ,config.dat”.

Erstellt eine neue leere Programmumgebung.

Speichert den Inhalt des Programmfensters in eine Programmdatei.

Uberschreibt die geladene Programmdatei mit dem Inhalt des Programmfensters.

L&dt eine neue Programmdatei.

Entfernt das aktuelle Programm aus dem Roboter

Online Hilfe zum Teach Window.

Edit-Zeile zur Ausfihrung eines Befehls

[ERLC TRACK ON Edit-Zeile mit ERCL Befehl ,ERC TRACK ON* zum Einschalten der TCP Spur.
Setzt den eingegebenen Programmcode an die markierte Position im
Quellcodefenster. Uberschreibt aktuellen Code.
Run Fuhrt den Befehl in der Edit-Zeile als Single Step aus.

Programmzeilen erstel

len / bearbeiten

Zeigt die aktuelle Zeilennummer im Quellcodefenster an.
Durch Klick auf den Button kann eine neue Zeilennummer eingegeben werden.

Der Stern nach der aktuellen Zeilennummer gibt an, dass der Programmcode
geandert wurde.

nzert

Fugt den eingegebenen Programmcode aus der Edit-Zeile an die markierte
Position im Quellcodefenster ein. Der restliche Programmcode wird nach unten
verschoben.

Schneidet den aktuell markierten Programmcode aus.
Der restliche Programmcode wird nach oben verschoben.

Flgt den letzten Programmcode der mit Del ausgeschnitten wurde wieder ein,
wobei der restliche Programmcode nach unten verschoben wird.

Copy

Kopiert die markierte Zeile in die Zwischenablage.

FPazte

Fugt an die markierte Zeile den Code aus der Zwischenablage ein. Der restliche
Programmcode wird nach unten verschoben.

L
=

()
o

bd cudify

Kopiert die markierte Zeile in die Edit-Zeile zwecks Bearbeitung oder Ausfihrung.

Find |2

Suche nach einem eingegebenen Text und der nachsten Position
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Verfahrbefehle entsprechend der aktuellen TCP-Position erzeugen

Home Fahrt den Roboter an seine Home-Position.

1:
T
=
£

Achsspezifischer Verfahrbefehl Synchro-PTP

ﬂ
= )
&

Aktuelle TCP Position wird mit dem Verfahrbefehl Synchro-PTP programmiert.

LIM Aktuelle TCP Position wird mit dem Verfahrbefehl LIN programmiert.
Aktuelle TCP Position wird mit dem Verfahrbefehl VIA programmiert.

Yig Hierbei handelt es sich um den fur die Kreisinterpolation erforderlichen
Zwischenpunkt.

q

Lirg Aktuelle TCP Position wird mit dem Verfahrbefehl CIRC programmiert.

Verfahrbefehle an Tag Punkten erzeugen

Auswahl eines Roboters oder Tag-Punktes durch Anklicken in der 3D Szene mit

Fick
der linken Maustaste. Der ausgewahlte aktuelle Tag wird mit einem rosa Pfeil
angezeigt.
Der Robotername bzw. der Name und Pfad des aktuellen Tags stehen im Status

Bar des Hauptfensters.

Auswahl von Pfaden und Tags.
Die ersten beiden <> Pfeile schalten die Pfade der Tag's weiter,
E die zweiten beiden <> Pfeile schalten die Tag’s weiter.
Name und Pfad des aktuellen Tags stehen im Status Bar des Hauptfensters.

Roboter bewegt sich zum aktuellen Tag mit der Bewegungsart, die dem Tag-
Punkt zugewiesen wurde, siehe Tag Window.

FTF Roboter bewegt sich in der Verfahrart Synchro-PTP zum aktuellen Tag.

LIN Roboter bewegt sich in der Verfahrart LIN zum aktuellen Tag.

Wia Der aktuelle Tag wird furr eine CIRC Bewegung als Zwischenpunkt gespeichert.
Roboter bewegt sich in der Verfahrart CIRC zum aktuellen Tag, wobei der VIA-

Punkt durchfahren wird.

Programmieren weiterer Bewegungsbefehle

[

Offnet neuen Dialog mit zuséatzlichen Bewegungsbefehlen. i | [PiracreL]

[__PTPREL | [ LIW_REL |

z.B. PTP_ReI, LIN_ReI.... usw. [a_Pos_REL | [__CRC_REL |

[__PTPclag | [ LINcTag |

Erlauterung der einzelnen Bewegungsbefehlen stehen in [ ¥AcTsg | [ ORCcTen |
der Dokumentation: ,ERPL-/ERCL Programmiersprache® Coecie] AoGaa]

und der Online Hilfe unter: Robot Motion Command e r——

|_BASE_PRG_ | [BASE_PRG_REY

[ Comments  [] Keepopen
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Teach Window

ﬁ

Robat
[ too. | [ cowmg |

Offnet neuen Dialog mit Steuerbefehlen.

[__5et Detauk SPEEDs and ACCELs |
SPEED_

z.B. Speed_CP, ACCEL_CP.... usw.
[ PIP&x | [ PIPOV |
Erlauterung der einzelnen Bewegungsbefehlen stehen ][t ]
in der Dokumentation: letfl [on07.]
+,ERPL-/ERCL Programmiersprache“in ‘[‘EE‘;L{PM | CEE
und in der Online Hilfe unter: Robot Control Command C o [ e
[ ORI ] [__oR_ov |
Mation Planner Settings
[__Zome | [ LeadingPDS |
[ Leading VAR ] [ Leading ORI ]
[__twor | [_CIRCOR_|

Program Contiol Statements

[FET s ENDFCT] [LIF(_ENDIF ]
[ CALLFET | [WHILE(D.. |
[_CALLFILE | [GDTOLABEL..]
‘wait for Signal

[] Comments [ Keep open

Clase

’ﬁ

Enable - Disable
[ oML ] [ OFFLJ ]

Offnet neuen Dialog mit EASY-ROB™ Commandos.

[ Set-, Unset cRobot [...]

J
J

z.B. ERC COLLISION ON, ERC TRACK OFF... usw. [ Lo=dl] ] [ Viewl.]
[ Pause | [ Unis[.] ]
[_ResetntPos. | [ SavedntPos. |

Erlauterung der einzelnen Befehlen stehen in der [ LAender WIRE | Fender SMOOTH

Dokumentation: ,ERPL-/ERCL Programmiersprache* Simulation Step Sizes

und in der Online Hilfe unter: T T o P T

ERCL - EASY-ROB™ Command Language Lip0 Leed e ] [IF0Ls0Tine |
[ CotlStep | [ SYSTEM Step |
[ Atach[.] ] [ Base[.] ]
[ Grabl.] | [ FReleasel.] |
[ Movel.] | [ FRendsil.] ]
[ Lstld ] [ Coler[] ]
[ NumsoL ] [ swE ]

[ Comments [ Keep open

Clase

* RN
PrgStep

Fuhrt den im Programmfenster markierten Befehl im Single Step (Einzelschritt)
aus.

Kurzhilfe zur Erlauterung der Buttons im Teach Window.

Offnet das Program Window, in dem alle ausgefiihrten Befehle angezeigt werden.
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Teach Window

Programmbeispiel:  ,KR30-2-TAGS.PRG"
aus ,..\ EASY-ROB \ Tutorial \ Functional \ KR30-2-
Tags.cel”

Programrile

! cRobot 'KR30-2°

! Below section is called once at t=0
! add Initialization commands here
EndInit

]

! Below section s called at =0
! add new ERPL / ERCL commands here
! set pefault SPEEDs and ACCELS

SPEED_PTP_Ax 40,0000
ACCEL_PTP_AX 40,0000

ERC TRACK OM

ERC COLOR TRACK GREEM
ERC TAG_COORSYS OM
ALOMG PATHOL

ERC COLOR TRACK  BROWM
ALONG KREIS

ERC TAG_COORSYS OFF

ERC COLOR TRACK ELUE
ALOMG PATHOL BE_L1 B_S

ERC TAG_COORSYS OM
ALOMG KREIS 2 14

ERC TAG_COORSYS OM
ERC COLOR TRACK  VELLOW

MOVE Pathl3:w_2 2
Home 1
]

EndProgramrFile

40,0000 40.0000 40,0000 40,0000 40,0000
40,0000 40.0000 40,0000 40,0000 40,0000

SPEED_CP 0.1000 0.0
ACCEL_CP 1.5000
SPEED_ORI 20.0000 0.0
ACCEL_ORT 40.0000
OV_PRO 100. 0000

ERC NO_DECEL OFF

ZONE 0. 0000
S

ERC TAG_COORSYS OFF

ERC ROBOT_BASE 000000
Home 1

ERC ROBOT_BASE 11000 -%0

ERC MOVE BODY CvL 0.5000 -0.5 0 -25.0000 o0

ERC MOVE BODY CvL Pathos tw_3
ALONG KREIS

Home 1

ERC TAG_COORSYVS OFF

ERC MOVE BODY CvL Pathos tw_d
ERC ROBOT_BASE Path0s iw_o

MOVE Kreis:B 1 3 5 7§ 11 13 15 B_16 Path0l:8_5 2 B_1 Path03 :w_HOME
38
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EASY'ROB ™ Bedienungshinweise
Dialoge & Windows

CAD-Import Window

EASY-ROB™ verwendet fur den Datenimport das 3D_Evolution® API von CT CoreTechnologie GmbH.
Der CT Kernel_IO wurde speziell fir den Datenimport entwickelt, so dass CAD Formate aus verschiedenen
CAD-Systemen importiert und optimiert werden kénnen.

Lesen Sie bitte zunachst das Kapitel ,CAD Import (CT Kernel_IO) in der Installationsanleitung !

Nach dem Konvertieren einer CAD Geometrie wird diese automatisch in die CAD Preview geladen.
Entsprechend der Anforderungen kann die Triangulierung des Bauteils (z.B. fiir die Datenreduktion) vom
Bediener beeinflusst werden. Mit ,Restore” wird das Bauteil erneut konvertiert und fur die Begutachtung
wieder automatisch in die CAD Preview geladen.

Fur weitere Optimierungen stehen Funktionen wie das ,mergen®, das ,healing” und das ,sewing“ zur
Verfugung.

Alle erforderlichen Funktionen sind im CAD-Import Window zusammengefasst.

Uber das Menii ,3D-CAD | Open CAD-Import Window* wird das Fenster gedffnet.

Y=Y

1 09:31:54 CAD-Import Window Convert CAD
/ 2 09:33:01 Start FlexLM CAD-Import \CT_Kernel
3 03 01 Stark FlexLM CAD-Import ... Done

Menu —»

Re Stare

Re Load Datenhandling

CAD Info

Merge

Tesselation
Triangle, Angle Triangulierung /
. | | Darstellun
Information < 9
Heal
SEw
P

Zusatzfunktionen
[Juser Color

D BsmType

Warning |

\ Close

Messages

File | Load Laden und konvertieren von Daten in die Arbeitszelle

File | Save Speichern der CAD Daten und der CAD-Import Message

File | Unload Entladen der CAD Daten aus der CAD Preview
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CAD-Import Window

Funktionen zum Skalieren, Setzen der Position, Anzeigen der Kanten, mergen

3D-CAD und Anzeige der Objektinformation
Settings Anzeigen, Verandern und Zuriicksetzen der Tesselierung
FlexLM Starten, Stoppen des FlexLM fiir den CAD-Import

Anzeigen des Logfiles und der Lizenz

Converk CAD

Laden und konvertieren von CAD Daten und automatisches laden in die CAD
Preview

Re Skore

Erneutes konvertieren der bereits geladenen Geometrie nach Beeinflussung der
Triangulierungsparameter (Tessellation) und erneutes laden in die CAD Preview

Re Load

Erneutes laden der konvertierten IGP Dateien

CAD Info

Anzeige der Objektinformationen wie Dateiname und Pfad, Anzahl Objekte,
Linien, Vertices, Polygone, Skalierung und Position

Merge

Beim ,Mergen® wird intern die Anzahl der Objekte reduziert und die Anzahl der
Polygone pro Objekt erhdht. So entstehen lange Polygonketten, die sich direkt in
die Grafikkarte (VBO - Vertex Buffer Objects) laden lassen

Tesselation

coars| | fine

Veranderung der Triangulierung der Geometrie von Solids.

Triangle, Angle

— p— Separate Beeinflussung der Polygongrof3e und des Winkels zwischen den

Polygonen bei Solids

[ |Heal .Heilen“ des Objektes. Offene Geometrien werden nach Mdéglichkeit geschlossen.

[Jsew Zusammenfassen von Kanten, die innerhalb einer bestimmten Toleranz liegen.

[Juser Color Die Originalfarben der Geometrie werden Uberschrieben. So kann die Farbe in
EASY-ROB nachtraglich geéndert

[ AsmType Berlcksichtigung der Assembly-Struktur (Funktion derzeit nicht belegt)

Warning el

Warnungs-Stufe; “ausfihrlich®, ,normal“ und ,keine Warnung*

Close

SchlieRen des CAD-Import Window
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EA SY' RO B ™ Bedienungshinweise
Mini Tutorial

Erzeugen von Tagpunkten an 3D Geometrien

Im Folgenden wird Schritt fiir Schritt beschrieben wie in EASY-ROB™ auf der Flache oder an einem Punkt
einer 3D Geometrie (Zylinder) Pfade und Tags erstellt werden. Pfade und Tagpunkte bleiben an der
Geometrie, auch wenn diese die Position &ndert.

Hinweis:
Lesen Sie auch den Bedienhinweise zu dem hier verwendeten Dialog Tag Window und 3D-Cad Window.

Schritt 1:

Laden des Roboters aus dem TrainLib-
Verzeichnis:

File / Load / Robot file

Als Beispiel dient der Roboter

ER431.

../ EASY-ROB / TrainLib / ER431.rob

Schritt 2:

Laden des Tools aus dem TrainLib- -l;(z)i(t)(len
Verzeichnis:

File / Load / Tool file

Als Beispiel dient das Tool: tool.tol TCP

../ EASY-ROB / TrainLib / tool.rob
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Tags an 3D Geometrien erzeugen

Schritt 3:

Zylinder (3D Geometrie) erstellen und
im Raum positionieren

MalRe:

Radius 200 mm
High1l 500 mm
Radius Top 200 mm
High2 500 mm

Offset-Position:

X 2000 mm

Y 0 mm

Z 50 mm

Rx 0°

Ry -10°

Rz 0°

Schritt 4:

Im TagWindow den Namen des #1/1 BODY-CYLINDER - Tag

Pfades und des Workobjektes sel Pth | [ || Path |Cwiobi | BEN
festiegen: / [ Fe Attach ][I:I-:nne][ New]

z.B. Pfad: Body
Wobj: Cylinder

Schritt 5:

selection Dialog
Der neu erstellte Pfad soll nun dem
Zylinder zugewiesen werden und sich Attach cPath BODY to

mit der Position des Zylinders Swarld

mitbewegen. -cRobaot 'ER 431" Base
- cRobat 'ER431' Tip

Wahlen Sie ReAttach - cRobat ‘ER 431" Ty
und 5 - Pick Body W

und klicken sie dann den Zylinder an. B - quit

o LD D —

Die folgende Abfrage ,Keep World
Position beantworten Sie mit ,Nein*.

Der Pfad mit seinen Tagpunkten hangt
nun am Zylinder.
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Tags an 3D Geometrien erzeugen

Schritt 6:

Das Koordinatensystem des Zylinders
hat eine andere Ausrichtung als das
Koordinatensystem des TCP’s.

Um den ersten Tagpunkt direkt aus der
Oberflache des Zylinderdeckels zu
platzieren,

- aktivieren Sie Pick a Tag und
klicken mit der linken Maustaste
(LMB) auf die gewiinschte Flache.

- erzeugen einen neuen Tag am
TCP des Roboters durch
einmaliges klicken mit der
mittleren Maustaste (MMB)

- weisen dem Tag am TCP des
Roboters durch einmaliges klicken
mit der rechten Maustaste (RMB)
die richtige Position am Zylinder
Zu.

Ein Doppelklick auf den soeben
erzeugten Tagpunkt im Tag Window
lasst den Roboter zum Tagpunkt
fahren.

Position auf der Geometrie auswahlen
neuen Tagpunkt am TCP erzeugen
Tagpunkt an Geometrieposition
platzieren.

Maustaste links:
Maustaste mitte:
Maustaste rechts:

Ausrichtung des Tags an die Flachennormale

Schritt 7:

Es sollen nun weitere Tagpunkte am
Zylinder erzeugt werden.

Offnen Sie des Navigator Window :

|

Schritt 8:

Punkte an einer Geometrie selektieren

Im Navigator Window —

Point Measure und Vertices
einstellen.

Sind Vertices aktiviert, werden die
Eckpunkte aller 3D Geometrien durch
gelbe Punkte angezeigt und kénnen
mit der linken Maustaste selektiert
werden.

e e N WVertices

| Pairt Measure M
[ Pick & Click | [ Camera |

O

Zylinder mit Vertices
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Schritt 9: Maustaste links: Position auf der Geometrie auswéahlen

Maustaste mitte: neuen Tagpunkt am TCP erzeugen
Um weitere Tagpunkte an den Maustaste rechts: Tagpunkt an Geometrieposition
Eckpunkten des Zylinders zu platzieren.

erzeugen, die die gleiche Ausrichtung
wie der erste Tagpunkt hat, muss der
erste Tagpunkt vorab angefahren
werden.

Selektieren Sie nun mit der linken
Maustaste (LMB) einen Punkt am
Zylinder

Erzeugen Sie mit der mittleren
Maustaste (MMB)einen neuen
Tagpunkt am TCP des Roboters.

Weisen Sie dem Tag am TCP des
Roboters durch einmaliges klicken mit
der rechten Maustaste (RMB)die neue
Position am Zylinderpunkt zu

Die letzte Aktion bewirkt, dass der Tag
vom TCP zum selektierten Punkt
springt.
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EA SY' RO B ™ Bedienungshinweise
Mini Tutorial

Multi-KIN

Beim Einsatz der Option “EASY-ROB™ Multi-KIN* kdnnen beliebig viele Roboter-Kinematiken (*.rob-
Dateien) mit inverser kinematischer Lésung und mehr als drei Achsen in eine Arbeitszelle geladen und
bewegt werden. Roboter bzw. Kinematiken mit bis zu drei Achsen, wie einfache Zufuhreinrichtungen,
Positionierer oder XYZ-Portale benétigen die Option “Multi-KIN“ nicht und kdnnen beliebig oft geladen
werden.

Mit der Option “Multi-KIN“ kdnnen samtliche Roboter innerhalb derselben Simulation kartesische Punkte im
Raum anfahren, so dass sowohl die Ablaufe zwischen Robotern als auch zusammen mit Férdersystemen
simuliert werden kénnen.

Es existiert nur ein Programm in der Arbeitszelle, das alle nétigen Befehle fiir alle Roboter beinhaltet.
Als Beispiel dient die Arbeitszelle ,tutorial_multi_kin.cel“ aus dem TrainLib-Verzeichnis.

Hinweis: Bitte lesen Sie auch den Abschnitt ,Teach Window* in den allgemeinen Bedienungshinweisen

[ File Robotics Simulation 3D-CAD Tags View Aux ?

v o e (b s e , i~ @ PidD{EED

ZooM

2o (Ve a(llle @ & ¢ e S Eer—

Wl view #1 xyz 474 5231 490, 0ri 220 -59, c0i 000 cTag: #2 PATH04.T_PALLETTE 2 Move World Cruise _ Trans_Abs NUM

Beispielzelle: ,tutorial_multi_kin.cel”
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Multi-KIN

Vorgehensweise beim Arbeiten mit MultiKin (Arbeitzelle ,,tutorial_multi_kin.cel)

Fir dieses Beispiel bitte die Arbeitzelle ,tutorial_multi_kin.cel* laden aus dem
TrainLib-Verzeichnis.

Kinematics Window
offnen

Uber das Menil Robotics / Kinematics Window oder die Tastenkombination ,Ctrl+K*

Roboter auswahlen

Mit den Pfeiltasten oder ,sel Robot“ den Roboter ,KR125-2 aktiv
setzen

Teach Window
offnen

neues Programm

Zeile aktivieren

active Zeile auf 10 setzen

Defaults setzen

Set Default SPEEDs and ACCELs

1. Roboter aktivieren

= ERC

cRobot / SET / KR125-2

Home Position

Home

At

I I i E : ¥
= i
= =

Tag auswahlen

L
]
£

Tag Punkt T_BOX_1 auswahlen

Tag anfahren

kM ove

Box anfahren

Box greifen

GRAB []/ Grab ,Bodyname® / BOX_1

Linear wegfahren

ats ats

= m

o mal m_|
=2 )

b fa}
S

LIN_Rel in Z um -1000 mm

Tag auswahlen

Pick.

Tag Punkt T_CONV_1lauswahlen

Tag anfahren

bd e

T_CONV_1 anfahren

Box loslassen

Release [ ]/ Release ,Bodyname® / BOX_1

Linear wegfahren

> Motion

LIN_Rel in Z um -200 mm

Home Position

Haome

Box bewegen

Ty S
rm m
m m m—'
) ) B

Move [ ]/ Move_Rel ,Bodyname” / BOX_1 in X=5200
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Multi-KIN

2. Roboter aktivieren | |z ERC cRobot / SET / IRB6400_M97

Fick

Tag auswéhlen

Tag Punkt T_BOX_G_2 auswaéhlen

Tag anfahren Move Tag Punkt T_BOX_G_2 anfahren

Tag auswahlen

Tag Punkt T_BOX_G_1 auswéhlen

Linear anfahren

Tag Punkt T_BOX_G_1 linear anfahren

Box greifen

GRAB []/ Grab ,Bodyname® / BOX_1

e =

a = — - —

(] el o B
Fa] i 0o

Linear wegfahren > hotion LIN_Relin Z um -200 mm

o
]
7

Tag auswahlen

Tag Punkt T_PALLETTE_2 auswahlen

Tag anfahren

Tag Punkt T_PALLETTE_2 anfahren

Tag auswahlen

Tag Punkt T_PALLETTE_1 auswahlen

Linear anfahren

Tag Punkt T_PALLETTE_1 linear anfahren

Box loslassen

Release [ ]/ Release ,Bodyname® / BOX 1

Home Position Home

(i)
(u1]
=
(1]

k- I

g = — o = —

! E & |12 E
0 = o m}

Programm speichern
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Multi-KIN

EASY-ROB™

Das Programm in der Ubersicht

Bedienungshinweise

ProgramFile

! cRobot 'KR125-2'

! Below section is called once at t=0
! Add Initialization commands here

|

Endinit

|

! Below section is called at t>0

I Add new ERPL / ERCL commands here

! Set Default SPEEDs and ACCELs

SPEED_PTP_AX 40.0000 40.0000 40.0000 40.0000 40.0000 40.0000
ACCEL_PTP_AX 40.0000 40.0000 40.0000 40.0000 40.0000 40.0000
SPEED_CP 0.2500 0.0

ACCEL_CP 1.5000

SPEED_ORI 20.0000 0.0

ACCEL_ORI 40.0000

OV_PRO 100.0000

ERC NO_DECEL OFF

ZONE 0.0000

ERC CURRENT_DEVICE SET KR125-2

Home 1

MOVE T_BOX_1

ERC GRAB BODY BOX_1

LIN_REL 0.0000 0.0000 -1.000 0.0000 0.0000 0.0000
MOVE T_CONV_1

ERC RELEASE BODY BOX_1

LIN_REL 0.0000 0.0000 -0.2000 0.0000 0.0000 0.0000
Home 1

ERC MOVE_REL BODY BOX_1 5.2000 0.0000 0.0000 0.0000 0.0000 0.0000

ERC CURRENT_DEVICE SET IRB6400_M97

MOVE T_BOX_G_2

LINT_BOX_G_1

ERC GRAB BODY BOX_1

LIN_REL 0.0000 0.0000 -0.2000 0.0000 0.0000 0.0000
MOVE T_PALLETTE_2

LIN T_PALLETTE_1

ERC RELEASE BODY BOX_1

Home 1

EndProgramFile

Programmbegin

Geschwindigkeits-und Beschleunigungsdef.
40 °/s fur alle Achsen

40 °/s2? fur alle Achsen

250 mm/s

1500 mm/s?

20 °/s

40 °/s?

programmierter Override in [%)]

kein Abbremsen OFF, Halt im Zielpunkt
Zonewert = 0 fine Punkt

Roboter ,KR125-2" aktiviert

Homeposition 1 anfahren

Box anfahren

Box greifen

Linear wegfahren um 1000 mm in Approach
Forderband anfahren

Box loslassen

Linear wegfahren um 200 mm in Approach
Homeposition 1 anfahren

Box relativ verfahren

Roboter 2 aktiviert

Box anfahren

Linear anfahren

Box greifen

Linear wegfahren um 200 mm
Palette anfahren

Linear anfahren

Box loslassen

Homeposition anfahren

Programmende

Technische Anderungen und Verbesserungen sind vorbehalten
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Mini Tutorial

Trajektorienplanung und -Interpolation

Die Trajektorienplanung hat die Aufgabe den Weg im kartesischen Raum vom Startpunkt A zum Zielpunkt B
so zu planen, dass die Interpolation pro Zeiteinheit Zielvorgaben fir den Roboter erzeugt. Fir die
Trajektorienplanung stehen die Verfahrarten Synchro-PTP, SLEW, LIN und CIRC zur Verfligung. Im
Folgenden soll auf den Zusammenhang zwischen Positions- und Orientierungsinterpolation eingegangen
werden und das daraus resultierende unterschiedliche Zeit- und Bewegungsverhalten.

Um den Weg von Punkt A zu Punkt B zu planen sind folgende Vorgaben notig

Start- und Zielposition mit Orientierung

Bahn- und Orientierungsgeschwindigkeit, sowie Beschleunigungen
Verfahrart

- Zusammenhang zwischen Positions- und Orientierungsfuhrung

Im folgenden Beispiel sind an einem Rechteck 4 Punkte programmiert, wobei jeweils zwei der vier Punkte
eine gleiche Orientierung haben. Die Punkt- oder Tagkoordinaten T2 - T5 sind in der folgenden Tabelle
eingetragen.

Tag X[mm] [ Y[mm] | Z[mm] | Rx[°] Ry [°] Rz [°]
T2 250 500 300 0 180 0
T3 1250 500 300 0 180 0
T4 1250 0 300 -45 180 0
T5 250 0 300 45 180 0

Um entlang der Kante des Rechtecks zu fahren wird die Verfahrart LIN gewahlt. In Abhangigkeit von der
gewahlten Interpolationsart fir die Orientierung und der Position werden sich verschiedene Taktzeiten
ergeben. Die nachste Tabelle zeigt die Wegabstande und die Orientierungswinkeldifferenzen zwischen den
Tagpunkten.

von - nach Weg Winkel
T2-T3 1000 mm 0° T2 3
T3-T4 500 mm 45° y
T4 -T5 1000 mm -90°
T5- T2 500 mm 45° s T4
X
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Trajektorienplanung und -Interpolation

In dem Beispiel
motion_planning_01.cel und dem
Verfahrprogramm
motion_planning_01.prg

(aus der TrainLib) soll der

KUKA Roboter vom Typ KR 125-2
die Ergebnisse darstellen.

ProgramFile

SPEED_PTP_AX 20.00 20.00 20.00 20.00 20.00 20.00
ACCEL_PTP_AX 10.00 10.00 10.00 10.00 10.00 10.00

SPEED_CP 0.2000 0.0
ACCEL_CP 0.1000
SPEED_ORI  10.0000 0.0
ACCEL_ORI  10.0000
ZONE 0.0000

LINT 2

!
ERC STATUS_OUTPUT ON 1 fname.dat O

LIN_ORI QUATERNION
LEADING_POSITION ON
ILEADING_ORIENTATION ON
ILEADING_POSITION VAR

call move()

ERC STATUS_OUTPUT OFF
!
PTPT_1
EndProgramFile
|

fct move()
SPEED_CP
LINT_3
LINT_4
SPEED_CP
LINT_5
LINT_2
endfct

0.2000 0.0

0.1000 0.0

Programmbegin
Geschwindigkeits- und Beschleunigungsdefinitionen

20 °/s fur alle Achsen

10 °/s? fur alle Achsen

200 mm/s  Bahngeschwindigkeit

100 mm/s?  Bahnbeschleunigung

10 °/s Bahn-Orientierungsgeschwindigkeit
10 °/s? BahnOrientierungsbeschleunigung

Zone = 0 -> exaktes Anfahren der Zielstellung, fine Punkt

Fahre zur Startposition T_2
!
Schreibe die Positionen und Geschwindigkeiten in die
Ergebnisdatei fname.dat

]

Interpolation der Orientierung nach Quaternionen

1. Versuch Orientierungs-Interpolationsart: Position
2. Versuch Orientierungs-Interpolationsart: Orientierung
3. Versuch Orientierungs-Interpolationsart: Variable

Fahre entlang des Rechtecks nach T_3,T_4, T 5und T_2

SchlieRBe die Ergebnisdatei fname.dat
!

Programmende
|

Begin der Funktion move()
Fahre mit 200mm/szuT_3und T_4

Fahre mit 100mm/s zu T_5und T_2

Ende der Funktion move()

Technische Anderungen und Verbesserungen sind vorbehalten
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Trajektorienplanung und -Interpolation

LEADING_POSITION ON

LEADING_ORIENTATION ON

LEADING_POSITION VAR

Drei Orientierungs-Interpolationsarten

Bei der Bahnplanung werden Position und Orientierung vorerst unabhangig voneinander geplant. Hieraus
ergeben sich in der Regel unterschiedliche Ausflihrungszeiten. In der Praxis ist es erstrebenswert, dass
Position und Orientierung synchron interpoliert werden. Die Orientierungsinterpolationsart legt nun fest
welche der geplanten Ausfiihrungszeiten dominant sein soll.

Die Ausfuihrungszeit wird durch die Position bestimmt. Nur wenn
diese 0 ist, ist die Ausfiihrungszeit die sich aus der Orientierung
ergibt dominant. Bei kleinen Ausfiihrungszeiten kdénnen die maximal
zulassigen Orientierungsgeschwindigkeiten Uberschritten werden,
was in der Regel zu Uiberhdéhten Gelenkgeschwindigkeiten und -
Beschleunigungen flhrt.

Die Ausfuihrungszeit wird durch die Orientierung bestimmt. Nur wenn
diese 0 ist, ist die Ausflihrungszeit die sich aus der Position ergibt
dominant. Bei kleinen Ausfiihrungszeiten kénnen die maximal
zuldssigen Positionsgeschwindigkeiten Uberschritten werden, was in
der Regel zu Gberhéhten Gelenkgeschwindigkeiten und -
Beschleunigungen flhrt.

Das Zeitverhalten ist Variable und wird durch die jeweils gréRere
Ausfiinrungszeit bestimmt. Eine Uberschreitung der maximal
zulassigen Gelenkgeschwindigkeiten und -Beschleunigungen wird
abgesehen in der Nahe von singularen Stellungen vermieden.
Nachteil: Die Prozessgeschwindigkeit ist nicht konstant. Diese
Orientierungs-Interpolationsart ist somit nicht praxisrelevant fur
Applikation wie Kleben, Schneiden, Fréasen, bei denen der Roboter
entlang eine Kontur mit konstanter Geschwindigkeit verfahren soll.

Die gesamte Ausfiuhrungszeit ,total Time* fur die drei Orientierungs-Interpolationsarten werden im
Robot IO Output Window ,current Motion Data“ angezeigt.

Entlang der Kontur des Rechtecks ergeben sich folgende verschiedene Ausflihrungszeiten.

LEADING_POSITION ON 285s
LEADING_ORIENTATION ON 28,0s
LEADING_POSITION VAR 295s
Technische Anderungen und Verbesserungen sind vorbehalten 100/109
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POS ON -70s
ORI ON -70s
POSVAR -70s

v

A
T2 T3

POSON -6,0s POS ON -45s

ORI ON -55s ORI ON -55s

POSVAR -6,0s POSVAR -55s
T5 T 4 v

A

POS ON -110s
ORI ON -10,0s
POS VAR -110s

LEADING_POSITION ON:

a) FUr den Weg von T_2 nach T_3 mit spos = 1000 mm werden bei einer programmierten
Geschwindigkeit von vpes = 200 mm/s und einer Beschleunigung von apes = 100 mm/s2 insgesamt
ts_pos = 7 Sekunden bendtigt.

Beschleunigungszeit tr1 = v/apos = 2,0 SEC  Sr1 = Vpos?/2apos = 200 mm
Bremszeit tr2 = v/apos = 2,0 SEC  Sr2 = Vpos?/2apos = 200 mm
Konstantverfahrzeit te = (Spos - Sr1 - Sr1)lv = 3,0 sec
Gesamtverfahrzeit ts_pos = tr1 + tc + tr2= 7,0 Sec

b) Fur den Weg von T_3 nach T_4 mit spes = 500mm ergibt sich bei gleicher Berechnung

ts_pos =4,5 Sekunden.

Fur die Winkelanderung von o = 45° ergeben bei einer programmierten Orientierungsgeschwindigkeit
von Vori = 10 °/s und einer Orientierungsbeschleunigung aori = 10 °/s2 insgesamt ts ori = 5,5 Sekunden

Beschleunigungszeit tr1 = Vorifaori = 1,0 SEC 0L r1 = Vori?/2a0ri = 5°
Bremszeit tr2 = Vorif@ori = 1,0sec ar= Vori2/2aori = 5°
Konstantverfahrzeit te = (o - arn - ar)/Vori = 3,5 sec
Gesamtverfahrzeit ts o = tn + tc + tr2= 5,5 sec

Fall b) zeigt, dass die Ausfihrungszeit ts_ori mit 5,5s gro3er ist, als die Ausflihrungszeit ts_pos mit 4,5s
die sich aus der Positionsrechnung ergibt. In diesem Fall ,LEADING_POSITION ON* wird die
kleinere Ausfiihrungszeit verwendet.

LEADING_ORIENTATION ON:

Die Betrachtung von Fall b) ergibt entsprechend der vorstehenden Berechnung fiir die
Orientierungsinterpolation eine Ausfuhrungszeit von 5,5s, die hier dominant ist und verwendet wird.

LEADING_POSITION VAR:

Bei dieser Orientierungs-Interpolationsart wird stets die grof3te Ausfihrungszeit verwendet. Somit
ergibt sich in der Summe auch die gro3te gesamte Verfahrzeit.

Technische Anderungen und Verbesserungen sind vorbehalten 101/109
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Ergebnisdatei ,,fname.dat*

Mit der Programmzeile ,ERC STATUS_OUTPUT ON 1 fname.dat 0“wird die Ergebnisdatei ,fname.dat"
im aktuellen Ordner erstellt. In jedem Simulationsschritt werden die kartesischen Positionen, Gelenkwinkel
und Gelenkwinkelgeschwindigkeiten aufgezeichnet. Die Programmzeile ERC STATUS_OUTPUT OFF
beendet die Aufzeichnung und schliel3t die Ergebnisdatei.

Erlauterung der Spalten in der Ergebnisdatei:

Spalte 1: laufende Nummer

Spalte 2: Zeit

Spalte  3: Position X in mm

Spalte 4: Position Y in mm

Spalte 5: Position Z in mm

Spalten 6-11: Gelenkwinkel der Achsen 1 bis 6 in [°]

Spalten 12-17: Gelenkwinkelgeschwindigkeiten der Achsen 1 bis 6 in [°/s]

Die Ergebnisdatei wurde fur die Bewegung von T_2 bis T_5 fiir die Orientierungs-Interpolationsart
LEADING_POSITION ON in ein Tabellenkalkulationsprogramm importiert, um die kartesischen
Geschwindigkeiten und Beschleunigungen fir die X- und Y-Richtung grafisch darzustellen.

250,00 -

200,00

150,00

100,00

50,00 A ’ \
0,00

0,)00 2,00 4,00 6,00 8,00 10,00 V) 14,00 16,00 18,00 20,00 22f0 24,00 26,00 28,00
-50,00 4

-100,00 -

-150,00 -

-200,00

-250,00 -

Geschw. in X

Geschw. in V‘

200,00

150,00 1
100,00
50,00

0,00

0,00 2,00 4,00 6,00 8,00 10,00 2, 14,00 16,00 18,00 20,00 22,00 24,00 26,00 8,
-50,00
-100,00 1
-150,00 1

-200,00

‘ e Beschleunigung X

Beschleunigung Y ‘

Die Verlaufe zeigen ein ruckfreies und -stetiges Geschwindigkeits- und Beschleunigungsprofil.

Hinweis: Die berechnete maximale Beschleunigung ist mit 150 °/s?2 um 50% hdher als die
programmierte Beschleunigung mit 100 °/s2.
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Hinweis:

Um in EASY-ROB™ ruckfreie” Bahnbewegungen zu berechnen sind folgende Einstellungen vorzunehmen.

Simulation  30-CAD  Tags Wiew Aux 7

+  Select Robot E @ ‘|§|

Menu -> Robotics -> cRobotMotion Planner

cRobot Tool Data
cRobot Base Position

Ipo Joint Code

|p0 CP Code cRobot Attributes

|p0 Circ Code cRaobot Program 3
cRobot Kinematics »
cRobot Dynamics 3

Controller
Motion Planner Data

cRobot Motion Planner

Applications 4

Ipo Joint Code API-IPC
Ipo CF Code AFPI-IPO
Ipo Circ Code API-IPC

v Open Kinematics Window  Cerl+k

Wahlen Sie fur den “l[po CP Code API-IPO* die Einstellung “2 - Jerkfree Vel-Prof. C3“.

1 - Geometric Vel-Prof. CO  Ohne Geschwindigkeitsprofil,
Beschleunigung und Ruck sind
nicht begrenzt.

2 - Jerkfree Vel-Prof. C3 Ruckfreier Geschwindigkeitsverlauf,
Beschleunigung und Ruck sind
stetig und begrenzt.

KR125-2 Select CP Flanner

1 - Geometric Vel-Prof. CO
2 - Jerkfree WelProf. ©3
3-ipo_cp_uzerl
4
R

- ip0_cp_user?
-inn rA ERr

Beispieldateien:

motion_planning_01.cel
motion_planning_01.prg
fname.xls
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EA SY'ROB ™ Bedienungshinweise
Multi-Program

Verwendung digitaler Signale

Bei Simulationen mit mehr als einem Programm in der Arbeitszelle (Multi-Program), miissen die Devices
miteinander kommunizieren. Dies erfolgt in EASY-ROB™ mittels digitaler Signale.

Im Grunde ist die Programmierung mit digitalen Signalen nicht sehr komplex. Das kann sich aber sehr
schnell &ndern, wenn entweder die Arbeitszelle und damit die Anzahl der kommunizierenden Programme
wachst oder der Programmierer generell ein paar einfache empfohlene Grundregeln auf3er Acht Iasst.

Empfohlene Grundregeln:

- Initialisieren Sie die Signale immer am Anfang des jeweiligen Roboterprogramms im
Initialisierungsbereich.

- Setzen Sie die Signale bei der Initialisierung immer auf Null (aus)

- Verwenden Sie bei der Namensvergabe fiir die Signale ,sprechende Namen® — das erleichtert die
Ubersicht

- Programmieren Sie die Kommunikation Schritt fur Schritt bzw. immer nur ein Device-Paar und
Uberprifen Sie sofort ob die Kommunikation einwandfrei und wie gewiinscht funktioniert.

Arbeiten Sie immer nach folgendem Grundsatz:
1. Wenn das Signal nicht gesetzt ist - dann setzt Device ,A” sein Signal
2. Device ,B" wartet solange bis das Signal von Device ,A" gesetzt ist und
3. Device ,B* setzt umgehend das Signal von Device ,A“ zurtck.

In den folgenden Programmausschnitten wird die Vorgehensweise verdeutlicht:

1. Der Roboter setzt einen Gegenstand auf dem Férderband ab

2. Wenn das Roboter Signal nicht gesetzt ist, dann setzt der Roboter das Signal auf ,1“ und teilt so
dem Forderer mit, das der Gegenstand da ist
Der Forderer wartet auf das Signal vom Roboter
Der Forderer setzt nach Erhalt des Signals das Signal des Roboters sofort zurlick
Der Forderer nimmt den Gegenstand mit, kommt zurlick und lasst los
Der Forderer setzt sein Signal auf ,1“ und teilt dem Roboter mit, das er wieder da ist
Der Roboter wartet auf das Signal vom Forderer
Der Roboter setzt nach Erhalt des Signals das Signal des Forderers sofort zurlick
Der Roboter nimmt den Gegenstand und fahrt weg

©CoNOO AW
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Beispiel

Roboterprogramm (Ausschnitt) Forderbandprogramm (Ausschnitt)

1. ERC RELEASE DEVICE BOX_TUTORIAL
2. WAIT_UNTIL_SIGNAL_UNSET rob01_out
2

. rob01_out=1 3. WAIT_UNTIL_SIGNAL_SET rob01_out

4. rob01 out=0
5. ERC GRAB DEVICE BOX_TUTORIA
5.PTP T_CONV_2
5.PTP T_CONV_1
5. ERC RELEASE DEVICE BOX_TUTORIAL
6. WAIT_UNTIL_SIGNAL_UNSET conv_out

7. WAIT_UNTIL_SIGNAL_SET conv_out 6. conv_out=1

8. conv_out=0

9. PTP T_BOX_TOP_1

9. ERC GRAB DEVICE BOX_TUTORIAL
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EASY-ROB™

Bedienungshinweise

Internet Links

EASY-ROB™

Link: https://easy-rob.com/downloads/

Bedienhinweise zu EASY-ROB™
bedienungs-hinweise.pdf

Bedienhinweise Spezielle Funktionen und Plugins zu EASY-ROB™

bedienungs-hinweise-funktionen-plugins.pdf

ERPL/ERCL - EASY-ROB™ Program Language

easy-rob-erpl_de.pdf

EASY-ROB™ Newsletter

Link: https://easy-rob.com/downloads/

Jahr 2018
Thema: Release 7.6 — Die neue Version

Jahr 2017
Thema: Release 7.3 — Die neue Version

Jahr 2016
Thema: Release 7.0 — Die neue Version

Jahr 2015
Thema: Release 6.6 — Die neue Version

Jahr 2014
Thema: Release 6.3 — Die neue Version

Jahr 2012
Thema: Release 6.0 — Die neue Version

Jahr 2011
Thema: Release 5.6 — Die neue Version

Jahr 2010
Thema: Release 5.3 — Die neue Version

Jahr 2009
Thema: Release 5.006 — Update

3./4. Quartal 2008
Thema: Release 5.0 — Die neue Version

1./2. Quartal 2008
Thema: Release 4.606 — Project Manager

Technische Anderungen und Verbesserungen sind vorbehalten

update-info-v76.pdf

update-info-v73.pdf

update-info-v70.pdf

update-info-v66.pdf

update-info-v63.pdf

news-04-12-d.pdf

news-04-11-d.pdf

news-02-10-d.pdf

news-07-09-d.pdf

news-10-08-d.pdf

news-03-08-d.pdf
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4. Quartal 2007
Thema: Release 4.603 — Multi-Program news-11-07-d.pdf

3. Quartal 2007
Thema: Release 4.307 - Update news-08-07-d.pdf

1./2. Quartal 2007
Thema: Release 4.305 - Die neue Version news-01-07-d.pdf

3./4. Quartal 2005
Thema: Neue Multi-Md6glichkeiten fur Multiple Kinematik ~ news-09-05-d.pdf

1./2. Quartal 2005
Thema: Release 4.0 bringt Multiple Kinematik news-03-05-d.pdf

3./4. Quartal 2004
Thema: API fur individuelle Kundenlésungen news-10-04-d.pdf

2. Quartal 2004
Thema: EASY-ROB™ Robotics Simulation Kernel
in Offlineprogrammiersystem FAMOS integriert news-06-04-d.pdf

1. Quartal 2004
Thema: Videomodus fir Simulationen news-03-04-d.pdf

4. Quartal 2003
Ihr neuer Begleiter — EASY-ROB News news-11-03-d.pdf

Prof. Dr. Thomas Horsch:
Introduction to Robotics: ,Module Trajectory generation and robot programming”
FH Darmstadt, Summer 2000,
Link: http://lwww.easy-rob.com/service/artikel-publikationen.html
LectureRobotics.pdf

Prof. Heribert Miinch, Dipl.-Ing. J. Bargfrede:
»=Universelle Koordinatentransformation fur Industrieroboter*
Hochschule Magdeburg-Stendal, August 2001,
Link: http://lwww.easy-rob.com/service/artikel-publikationen.html
paper_unitrans.pdf

Janko Hartig: Praktikumsarbeit bei EASY-ROB™
Roboterkinematiken ,Direkte- und inverse Koordinatentransformation®
Hochschule Mittweida (FH), Juli 2004,
Link: http://www.easy-rob.com/service/artikel-publikationen.html
bps-inverse-kinematik-jhaertig.pdf

Dipl.-Ing. S. Anton:
.Inverse Kinematik am Robotersimulationsprogramm EASY-ROB™*
1. Workshop Robotik, Hochschule Mittweida (FH), Oktober 2004,
Link: http://www.easy-rob.com/service/artikel-publikationen.html
EASY-ROB-Inverse-Kinematik.pdf

Institut fir Automatisierungstechnik, Hochschule Mittweida (FH)
Link: http://www.global.hs-mittweida.de/~ifa/archivrobotik.htm
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Kontakt

EASY-ROB Software GmbH
Adresse: Hauptstr. 42
65719 Hofheim am Taunus

Germany

Kontaktperson: Stefan Anton

Tel.: +49 (0) 6192 921 70 77
FAX.: +49 (0) 6192 921 70 66
Email: contact@easy-rob.com

sales@easy-rob.com

Url: WWwW.easy-rob.com

EASY-ROB Kundenbereich

Inhalte: Programm-Updates und Roboter Bibliotheken

Web-Adresse: www.easy-rob.com/downloads/kundenbereich/

Zugangsdaten:
Benutzer:  customer
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Platz fur lhre Notizen
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